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1 Introduction 
Breezing forms is a complete Customizable  solution for your Joomla!™ powered website. 
As the #1 Component to creating amazing Customizable Forms, Breezing Forms I praised 
on its ability to deliver an easy to use, yet powerful, solution to Creating Registrations 
forms, appointment calendars, and even Job Applications. 
 
Its mission is simple: create a amazing form with little to no experience in coding. 
If you want absolute power and flexibility, Breezing Forms is right for you, too! It puts you 
in charge of creating dynamic forms. Look at the different feature and modes below to see 
which category fits you best. 
 
* QuickMode:  
A form editor for the non-programmer and people who want their forms to be done very quickly but 
nice looking. 
 
* EasyMode:  
A form editor for layout centric form creation. Very powerful but simple in usage. Ideal for designers. 
 
* ClassicMode:  
A wysiwyg editor for creating forms. For technicians and fans of FacileForms. 
 
 

Feature QuickMode EasyMode ClassicMode 

Target Audience Non-Programmers Designers Technicians 

Custom validations and actions yes yes yes 

Display Type Managed Layout based Free float 

Display-Edit Records (front- or backend) yes yes yes 

MailChimp® Integration yes yes yes 

Ajax File Uploads (Progress Bar) yes no no 

Turn fields on/off conditionally yes no no 

Summary item yes no no 

Maxlength for textareas (including counter) yes no no 

Built-In validations and actions yes yes yes 

Form elements All + many special All + many special All + Captcha 

Multipage forms yes yes yes 

Reply-To fields yes yes yes 
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Feature QuickMode EasyMode ClassicMode 

Custom mail subjects yes yes yes 

Mail templates yes yes yes 

File attachments yes yes no 

Form import and export yes yes yes 

Database storage yes yes yes 

CSV, PDF & XML export yes yes yes 

Data integration yes yes yes 

Captcha (+ reCaptcha for QuickMode) yes yes yes 

Calendar item yes yes yes 

PayPal (includes pay to download file) yes yes no 

DirectPayment (Sofortüberweisung) yes yes no 

 
So whether you’re looking to build a simple contact for or a complex Room Booking Form, 
This component is right for you. 
 
 

2 Getting Started 
 

2.1  Subscription Plans Disclaimer 

Our subscription plans are especially targeted on people and businesses that need frequent updates and 

support. Each plan includes the following services: 

 Unlimited use of all extensions (or templates if a template club has been chosen) from the plan 

selected: No support-per-domain restrictions. No limits on numbers of installations and servers, 

infinite use beyond expired plans, no hidden extra costs 

 Unlimited access to all extensions (or templates if a template club has been chosen) that are included 

in your selected plan during the course of your subscription 

 Unlimited access to all updates of extensions that are included in your selected plan at any time 

during the course of your subscription 

 Unlimited access to video tutorials, documentations and our knowledgebase with tips and best 

practices 

 Club Forum access with prioritized answers from our team 
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The 6-months plan includes 6 months access to all extensions (or templates if a 
template club has been chosen) that are included with your selected plan + 3 months 
of support. 

 

The 1-year plan includes 12 months access to all extensions (or templates if a 
template club has been chosen) that are included with your selected plan + 6 months 
of support. 

 

The professional plan includes timely unlimited access to all extensions, form apps, 
breezingforms themes and templates that are included with the selected plan + 12 
months of support. 

Reaction time is usually within 24 to 48 hours. You will receive adequate and professional answers to 

each of your support requests but there is no guarantee on reaction times. Under certain circumstances 

(weekends, public holidays and heavy workload), there might be delays. If communicating with our 

support, make sure your email address given to support is correct and check your spam folders if 

answers seem overdue. 

Support languages: 
Native English 
Native German 

 

Included in support: 
Installation help 

General usage help 

 

NOT Included in Support: 
Custom programming 

Consulting 
Fixing of 3rd party caused issues 
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2.2 Refunds 

We grant refunds on a case-by-case basis. Please contact our support if you feel you should 
receive a refund. In general, there are no refunds based on subjective experiences like "but 
I thought it can do this" or "it is not easy". The features of each extension are explained 
clearly and there are demos and videos available that give a broad overview if the 
extension fits your level of experience. On doubts, please contact the support before 
purchasing. There is also no refund possible on support matters. For example: a 3rd party 
extension/template is causing conflicts with one of our extensions, it is up to the 3rd party 
developer to fix this problem - please consult the 3rd party developer's support or request 
a refund there. We can help you collecting evidence that the issues are not on our side or -- 
if time allows -- exceptionally provide a workaround. Our extensions are developed to 
work on regular and properly configured systems, as you can see on our demo pages. 
Thank you for your understanding. 

NOTE: Unlike others, there are no domain, or server restrictions of any kind - no domain limitations on 

support - You are free to use our products the way you want, as long as you want! 

2.3 Requirements 

 
 Joomla!® 1.5.x, 1.6.x, 1.7.x or 2.5.x,  
 PHP 5+,  
 MySQL 3+,  
 Firefox 3.x or Google Chrome (very fast!) for the EasyMode  
 Any other modern browser for the Quick and ClassicMode.  
 This package includes the latest version of the component, the module, the plugin and the mmfuncs. 

3 Installation / Setup 
If your product is a piece of software that users can install on their machines, be sure to 
include thorough instructions for each particular operating system you support.  The idea 
is get the user up and running as quickly as possible.  Screenshots are especially helpful at 
this stage. 
 
For a complete installation of BreezingForms, there are three separate elements that you 
will need to upload and install: 
 

 Component - for basic form functionality 
 Plugin - allows you to embed a form in an article 
 Module - allows you to use a form in a module position 

So, let's get you started! The first thing you'll need to do is: 
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Download and Unzip BreezingForms 
Download the latest BreezingForms package 
(BreezingForms_*version*_UNZIP_FIRST.zip). 
 
The newest version of BreezingForms is available here. 
The older, free version of BreezingForms is available for download at the Joomla! Extensions 

Directory. 
 
Unzip the package using your favorite file extraction program. Once unzipped, your file 
folder should look something like this: 

 

 

Install the Component 

STEP 1 OF 2 

 
Log into your Joomla! administrator and go to Extensions > Install/Uninstall. 

 
 

http://crosstec.de/en/my-downloads.html
http://extensions.joomla.org/
http://extensions.joomla.org/
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In the extension manager, under Upload Package File, click on the BROWSE button (A) and 
navigate to the unzipped BreezingForms folder. (You must unzip the initial Breezing 
Forms download file before you start.) 
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Select the package, com_breezingforms_*version*.zip, click OPEN (B), and then click on 
Upload and Install (C). 
 

 
 
You will then see the following on-screen message (D) with a reminder (E) to proceed to 
Step 2 to complete installation. 
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STEP 2 OF 2 

To complete the installation, go to the menu Components > BreezingForms > 
Configuration. 
 

 
 
First Time Installation: If you are installing BreezingForms for the first time, in the Select 
database install/update mode, choose "New install: Create tables (drops existing 
tables)." (F) 
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Reinstalling or Upgrading: If you are reinstalling or upgrading BreezingForms, then in 
the Select database install/update mode,choose "Reinstalling 1.4.* (Table structures are 
up-to-date)." (G) 
 
You have the option to load the sample forms with your installation. If you'd like to do so, 
check the box to the left of "Sample forms (Samples)." (H) 
 
Click on Continue (I) to complete installation and you should see the following message: 
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Alternate Component Installation 

STEP 1 OF 2 

Occasionally, Joomla's Extension Manager will fail to install the component. If that happens, 
please take these steps instead: 
 
1. Unzip the initial BreezingForms zip file 
(breezingforms_*version*_UNZIP_FIRST.zip (i.e. breezingforms_175_UNZIP_FIRST.zip). 
Once unzipped, you should have a folder which contains the following: 

  
2. Now unzip the com_breezingforms_*version*.zip file (i.e. com_breezingforms_171.zip). 
Once unzipped, you should have a folder which contains the following: 
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3. Next, login to your server via FTP or through cPanel's file management system and 
navigate to the /tmp/ directory in your Joomla root. Double-click on it, and then create a 
new directory which we'll call bf_install for the purpose of this example. 

  
4. Once created, double click on the bf_install folder to open it. 
5. In the left-hand directory tree in your FTP tool or cPanel screen, navigate to the folder 
where you unzipped the com_breezingforms_*version*.zip file and double-click on it. Then 
select all of the folders and files in that window for upload into 
your/tmp/bf_install/ folder. 
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Your /tmp/bf_install folder on the right-hand (Remote System) side should now contain 
all of the files and folders shown in the left-hand (Local System) side of the screen above. 
 
6. Log in to your Joomla! administrator and go to Extensions > Install / Uninstall. 
 

  
7. In the Install From Directory field, specify the path to the /tmp/bf_temp/ directory 
that you just created. Note: The text below is only anexample. You will likely need to 
include the full path to your /tmp/bf_install folder. Then click on the INSTALL button. 
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You will then see the following on-screen message (D) with a reminder (E) to proceed to 
Step 2 to complete installation. 
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STEP 2 OF 2 

To complete the installation, go to the menu Components > BreezingForms > 
Configuration. 
 

 
 
First Time Installation: If you are installing BreezingForms for the first time, in the Select 
database install/update mode, choose "New install: Create tables (drops existing 
tables)." (F) 
 



[User Guide]  [Crosstec/Breezing Forms] 

Page 16 

 
Reinstalling or Upgrading: If you are reinstalling or upgrading BreezingForms, then in 
the Select database install/update mode,choose "Reinstalling 1.4.* (Table structures are 
up-to-date)." (G) 
 
You have the option to load the sample forms with your installation. If you'd like to do so, 
check the box to the left of "Sample forms (Samples)." (H) 
 
Click on Continue (I) to complete installation and you should see the following message: 
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Install the Plugin 

The BreezingForms plugin enables you to embed a form within an article on your Joomla 
site. To install the plugin, please follow the steps below. 
 
Log into your Joomla! administrator and go to Extensions > Install/Uninstall. 
 

 
 
In the extension manager, under Upload Package File, click on the BROWSE button (A) and 
navigate to the unzipped BreezingForms folder. (You must unzip the initial BreezingForms 
download file before you start.) 
 
Select the package, plg_breezingforms_*version*.zip, click OPEN (B), and then click on 
Upload and Install (C). 
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Once successfully installed, you'll see the following screen (which will also provide you 
with information on how to use the plugin): 

 

 
For Easier Use here is a copy of the code: 
 

Requirements: 
 The BreezingForms component must also be installed (same version) 

 The bot must be published 

Pattern syntax: 

{ BreezingForms : formname [, page, border, urlparams, suffix ] } 
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Parameter description: 
BreezingForms : This tag must be present literally and in exact upper/lowercase. 
 
formname    : The name of the form to include, also in exact upper/lowercase. 
 
page        : The starting page number.   Defaults to 1 when omitted. 
 
border      : 0=no border, 1=with border. Defaults to 1 when omitted. 
 
urlparams   : Parameters to pass in URL style (no commas or closing brackets allowed). 
 
suffix      : Suffix appended to all CSS class names in the form. 
 

Examples: 

{ BreezingForms : SampleContactForm } 

 

{ BreezingForms : MyVeryForm, 2 } 

 

{ BreezingForms : AnotherForm, 1, 0, &amp;ff_param_xy=123&amp;ff_param_foo=bar } 

 

{BreezingForms:testform,,,&amp;ff_param_foo=bar,mysuffix} 

 
 
But attention with the following one. Basically it would work, but when using a WYSIWYG editor, it will insert line 

breaks as <br/>and the bot will no longer recognize the pattern: 

 

 { 
  BreezingForms: 
 
   AnotherForm, 
   1, 
   0, 
   &amp;ff_param_xy=123&amp;ff_param_foo=bar 
 } 
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Install the Module 

1. Log into your Joomla! administrator and go to Extensions > Install/Uninstall. 

 
2. In the extension manager, under Upload Package File, click on the BROWSE 

button (A) and navigate to the unzipped BreezingForms folder. (You must unzip 
the initial BreezingForms download file before you start.) 

3. Select the package, mod_breezingforms_*version*.zip, click OPEN (B), and then 
click on Upload and Install (C). 

 
4. Once successfully installed, you'll see the following screen: 
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Installation Errors You May Receive: 

Timeout Errors / White Screen on Installation 
When I try to install the BreezingForms component, I get a timeout error. What should I do? 
If you receive timeout errors or a white screen when trying to install the component, then it 
is likely that you don't have native zip support installed and/or activated with your php 
installation. 
 
If you encounter this error, you can make your life easier by enabling it in your php.ini file; 
or if you are the administrator, install it if is not already installed. 
 
For Windows machines using XAMPP, you would do this by removing the ";" in the php.ini: 
 
;extension=php_zip.dll 
 
If you do not activate native zip support, Joomla! uses an alternative way of unzipping, 
which seems to be a lot slower OR causes an infinite loop. 
You could also try using the alternate installation method described here: 
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=6 
  

 
 
Components Menu on Installation Shows All BreezingForms Links Separately 
After I installed BreezingForms, the components menu shows all the links separately (like 
Manage Records, Manage Forms, etc.),  instead of showing the BreezingForms menu with the 
other links dropping down when it's moused over. Why would this happen? 
 
Some possible reasons for this are: 
1. The /tmp folder at your Joomla root isn't writable. Permissions should be set to 0755. 
2. The path to the /tmp folder is incorrectly stated in Joomla's Global Configuration 
settings.  
The installation process requires use of the /tmp folder while in progress, and if it is not 
available, the installation will not finalize.  
  

 
 
Installation Fails with JFolder Error 
When I try to install BreezingForms, I get an error that says: 
* JFolder::create: Could not create directory 
* Warning! Failed to move file. 
What do I have to do to get this installed?  

 
1. Check your FTP settings and make sure that they are correct. If they are correct but you 
are still getting that error, then try #2 below. 
 

http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=6
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2. Go to Help > System Info > Directory Permissions and make sure that your directories 
are writable. If not, it would definitely affect the ability to install, save changes, etc.  
 
Below is a link to the Joomla Help site where they discuss the need for writable directories. 
Start at this page: 
 
http://help.joomla.org/screenbooks/JoomlaHelp_web/Joomla/B1_Installation/Books/B3_The_Joomla_I
nstaller/slide05.htm 
 
And then click through the slides for more information.  
 
Here is another post with additional information: 
 
http://forum.joomla.org/viewtopic.php?t=121470 
 
Try changing permissions as they recommend, and check to see if your BreezingForms 
installation works correctly after that. 
If it doesn't, then I would recommend you use the alternate installation method. For more 
information, please see this KnowledgeBase article: 
 
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=6 
  

 
 
Installing with XAMPP 
  
I am trying to install BreezingForms on an XAMPP server but have been unsuccessful in 
getting it to work. 
  
If you are using version 1.7.4, you might want to consider downgrading to version 1.7.3. 
Many forums indicate that XAMPP 1.7.4 is not a very stable application. Joomla and many of 
its extensions (including BreezingForms) have some serious problems with it. 
 

 
 
Buttons and Menu Items Missing in Admin 
  
After doing an install, all of the buttons and menu items are missing from my BreezingForms 
admin. There is just PHP text where the buttons and menu items should be. 
  
Try uploading the languages files to your server -- it sounds like they are either not there or 
didn't get overwritten with the new files. 
 
Unzip the com_breezingforms.zip file and upload the files noted below to the locations 
described: 

http://help.joomla.org/screenbooks/JoomlaHelp_web/Joomla/B1_Installation/Books/B3_The_Joomla_Installer/slide05.htm
http://help.joomla.org/screenbooks/JoomlaHelp_web/Joomla/B1_Installation/Books/B3_The_Joomla_Installer/slide05.htm
http://forum.joomla.org/viewtopic.php?t=121470
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=6
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Unzipped file: /admin/languages/en-GB/admin/en-GB.com_breezingforms.ini 
Upload to: /JoomlaRoot/administrator/language/en-GB/en-GB.com_breezingforms.ini 
 
Unzipped file: /admin/languages/en-GB/admin/en-GB.com_breezingforms.menu.ini 
Upload to: /JoomlaRoot/administrator/language/en-GB/en-
GB.com_breezingforms.menu.ini 
 
Unzipped file: /admin/languages/en-GB/admin/en-GB.com_breezingforms.sys.ini 
Upload to: /JoomlaRoot/administrator/language/en-GB/en-GB.com_breezingforms.sys.ini 
 
Unzipped file from: /admin/languages/en-GB/public/en-GB.com_breezingforms.ini 
Upload to: /JoomlaRoot/language/en-GB/en-GB.com_breezingforms.ini 
 
  

 
 
Warning: Invalid Argument Supplied Installation Error 
  
After installing BreezingForms on my server, I got an error message that says: 
 
Warning: Invalid argument supplied for foreach() in 
C:\Joomla\libraries\joomla\database\database\mysql.php on line 678  
 
Warning: Invalid argument supplied for foreach() in 
C:\Joomla\libraries\joomla\database\database\mysql.php on line 678  
 
Please check your Joomla Global Configuration settings to see which SQL version you are 
using. If it is set to mysql, try changing it tomysqli (or vice versa) and see if that makes a 
difference. 
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Upgrading to Version 1.7.5 from Version 1.7.1 Build 730 to 
Version 1.7.3 

Upgrading to Version 1.7.5 from Version 1.7.1 Build 730 to Version 1.7.3  

To upgrade to BreezingForms 1.7.5 from BreezingForms 1.7.1 Build 730 through Version 1.7.3, 
unzip the upgrade file and then follow the instructions as noted below. 

1. IMPORTANT!!! Save and backup your Joomla installation files and database before 
upgrading!   

2. If you have any custom QuickMode themes, PDF templates, Email templates or any other custom 
resources, copy them from your server to your hard drive using your FTP client. 

3. Using an FTP client, copy the contents of the folder /component-files/administrator/ to your 
Joomla's /administrator/ directory. 

4. Using an FTP client, copy the contents of the folder /component-files/components/ to your 
Joomla's /components/ directory. 

5. Using an FTP client, copy the contents of the folder /component-files/language/ to your 
Joomla's /language/ directory. 

6.  Using an FTP client, copy back to the server all of your custom QuickMode themes, PDF 
templates, Email templates or any other custom resources that you saved in Step 2 above. 

7. (Re-)install the plugin and module if you are using them. 
 
8. In some cases you will need to re-assign the validations and actions in your forms. So check your 
form validations right after the upgrade to make sure they're okay. 

That's it, you're all done! 
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Using Breezingforms 

Manage records: 

 
Here on the manage forms page is where you come to see all of the forms submitted to the 
database. From here you can view, export and even check payment and download times of 
a form.  
 

 
 
PDF, CSV and XML Buttons: Allows you to create files of the selected records 
 
All Form, Viewed, exported and Achieved Buttons :  Allow you to switch the view of the 
records to the corresponding button to see if the items were used or not for the selected 
buttons. 
 
 

Manage Errors/Issues You May Receive: 

CSV Exports Aren't Opening Correctly 
I am trying to export records from within BreezingForms to Excel in CSV format, but when the 
file opens, the columns aren't formatted correctly. How can I fix it? 
If you are using Excel 2003, you should use the semicolon ( ; ) as the separator. If you are 
using 2007, you should use the comma ( , ) as a separator. 
 
During the export, instead of opening the file in Excel immediately, choose the option to 
save it instead. Once saved, go to the file directory where you stored it and rename the file 
from FILENAME.csv to FILENAME.txt.  
 
Then open the TXT file in Excel. When you try to open it, you should see a Text Import 
Wizard dialog box. The fields should be completed as follows: 
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Choose the file type: DELIMITED (not Fixed Width) 
Start Import at Row 1 
Click NEXT 
 
Delimiter should be ; or , depending on which you entered in the configuration 
Text qualifier should be " unless you have changed it 
Click NEXT 
 
You can choose format for each column if you'd like to use it, then click FINISH. Your data 
should now open in column form. 
 

 
 
Export Records to Excel 
In my Manage Records section, I created a CSV file, but when I import it into Excel, it's all 
bunched up in the first column. How do I fix it? 
If you go to Components > BreezingForms > Configuration, you will see that there are some 
variables at the bottom that affect how your CSV file is exported. You could try changing the 
comma separator to a semicolon (which one to use depends on which version of Excel you 
have). You could also try switching the linebreak setting from 'Normal' to 'Masked' (or vice 
versa). 
 
Also, this information found on the Microsoft website might help: 
 
ISSUE: 
All of the text in the file appears in the first column. 
 
SUGGESTED FIX: 
1. Select the range of cells that contains the text values. The range can be any number of 
rows tall, but no more than one column wide. 
 
Note:  There must be enough blank columns to the right of the selected column to 
accommodate the columns of data you want to create or the data to the right of the selected 
column will be overwritten. 
 
2. On the Data menu, click Text to Columns. 
 
3. Follow the instructions in the Convert Text to Columns Wizard to specify how you want 
to divide the text into columns. 
 

 
 
Allow Manager Access 
I want one of my staff with Manager-level rights to be able to access the records in 
BreezingForms, but only an Administrator can. Is there a way around that? 
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Yes, there is.  Please note, however, that this code fix will give a Manager access to ALL 
areas of BreezingForms, not just the Manage Records section. 
To grant rights to a Manager within BreezingForms, open this file: 
In BreezingForms Build 730 and higher: 
/administrator/components/com_breezingforms/admin.breezingforms.php 
  
In BreezingForms Build 729 and lower: 
/administrator/components/com_facileforms/admin.facileforms.php 
 
Look for: 
 
 

if ($my->usertype != 'Super Administrator' && $my->usertype != 'Administrator') { 

 
 
and change it to: 
 

if ($my->usertype != 'Super Administrator' && $my->usertype != 'Administrator' && $my-
>usertype != 'Manager') { 
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BreezingForms Configuration 

How do I configure BreezingForms once it is installed? 

Configuration 

Once the BreezingForms component is installed, click on the Configuration link to access the 
configuration settings. 

 

 Use live site in configuration.php 
If you select "Yes" here, it will force the form to use the $live_site variable in the php.ini file; 
however, it is deprecated, so in most circumstances, you should leave this set to "No." 

 Run backend preview in an iframe 
If you select "Yes" here, true WYSIWYG with the front-end stylesheet will be enabled. 

 Preview window grid size 
This field applies only to forms created in Classic Mode. If you would rather not use the grid, 
their is an option to turn it off while in Classic Mode. 

 Use WYSIWYG editor for text elements 
The WYSIWYG editor is selectable in Joomla's global configuration options. On this screen, 
the option should remain set at "No." 

 Compress JavaScript and HTML 
If "Yes" is selected, compressing the JavaScript and HTML will reduce the traffic from the 
server to the browser. However, if you are trying to debug the code, you will need to set this 
option to "No." (Remember to revert the option back to "Yes" when debugging is complete.) 

 Get provider with GetHostByAddr 
If you want to know the Hostname of the user filling in the form, then select "Yes" here. The 
information will then be sent to you via the email notification's header, as well as being 
stored in the database. Choosing this option could result in a heavier server load and slower 
response time, so unless there is a specific need to get the Hostname, it is recommended 
that the setting be kept at "No." 
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 Number of lines for textareas 
With this field, you can define for yourself how large the textareas should be. This can be 
used in classic mode where you add scripts and pieces, in the other modes on the form 
settings screen, as well as for the Scripts and Pieces Libraries. (More information will be 
added in the applicable sections.) 

 Limit descriptions in listviews to XX characters. 
This field defines the size of the textarea in the Scripts and Pieces Library that shows the 
description of each script and piece. 

 Default email notification address 
In this field, please enter the default Email address you wish to use. If you wish to add more 
than one Email address, separate them with semi-colons, like this: 
 
EmailAddress1;EmailAddress2;EmailAddress3 
 
The first Email address will become the 'REPLY-TO' address, and it, plus any additional 
Email addresses listed after it, will receive a copy of the form but only if the MAIL 
RECIPIENTS field in the form properties for a specific form is left blank. 

 Path for {ff_images} substitute 
Unless you have changed the default directory name for BreezingForms, this should be left 
as is. 

 Path for {ff_uploads} substitute 
Unless you have changed the default directory name for BreezingForms, this should be left 
as is. 

Once you have finished making changes, click on the SAVE icon at the bottom of the screen. 
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Packages 

What is a package? 

There may be times when you want to copy one of your forms to another domain. Perhaps you 
created it on a test site and now need to install the final version on your client's server, or maybe 
you've created a custom form for use on all of your client sites.  

Using BreezingForm's 'Package' option in the BreezingForms configuration screen, copying forms 
from one domain to another is a BREEZE, as long as the other domain is running Joomla! with 
the SAME OR A NEWER VERSION of the BreezingForms extension. (There may be some 
instances where it could be backwards-compatible and work on a site running an earlier version, but 
this cannot be guaranteed, though in most cases it should work with a form created using Classic 
Mode.) 

When you create a package, you are actually creating an XML file which can then be shared with 
others. To send it via Email though, you might have to zip the file first, as not all Email applications / 
webhosts will accept XML files. 

Create a Package 

How do I create a package? 

Create Package 

To create a package for installation on another domain, here's what you'll need to do. Go to 
Components > BreezingForms > Configuration. In the BreezingForms configuration screen, you'll 
see this: 

 

 Click on 'Create Package' at the bottom of the Configuration screen. 
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 ID 
Leave the ID section blank. 

 Package Name 
Give your package a name file name (no spaces). 

 Version 
Assign a version number to your form. 

 Package Title 
Enter the title of your package (spaces are allowed). 
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 Author Name 
Enter your name. 

 Author Email 
Enter your Email address. 

 Author URL 
Enter your website URL, if applicable. 

 Description 
Enter a brief description of your package and/or form. 

 Copyright 
If there are copyright restrictions on your package or form, enter the terms here. 

 Form Selection 
Select the form that you wish to include in the package. 

 Backend Menuitem Selection 
Choose the Backend Menuitem that you wish to include in the package, if applicable. 

 Script Selection 
If you have created any custom scripts that should be exported with your form, select them 
here. 

 Piece Selection 
If you have created any custom pieces that should be exported with your form, select them 
here. 

 Then click on the Continue button. You will be prompted to save an XML file. (Be aware that 
your browser might block, or attempt to block it. Check for any warnings in that regard.) 

 

 

Install a Package 

How do I install a package? 

Package Installer 

To install a package, here's what you'll need to do. Go to Components > BreezingForms > 
Configuration. In the BreezingForms configuration screen, you'll see this: 

 

 Click on 'Package Installer' at the bottom of the Configuration screen. 
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 Upload File 
Choose whether to upload the file from your hard drive ('from client') or from a file on your 
server. If you are uploading a file from your hard drive, you will see a 'Browse' button. Click 
on it to locate the package you wish to upload. 
 
If you are installing a package from a file on a server, select that radio button. In the field 
below, enter the path or URL to the file you are uploading. 
 
Then click on the "Install Package" icon locate at the top of the right-hand side of the page. 

 Package Installation Report 
Once installed, you will be directed to a Package Installation Report which contains a 
summary of the information provided by the package creator. 

 Complete Installation 
Click on "Continue" to complete the installation. Your form should now be accessible through 
the 'Manage Forms' link. 
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Manage Forms (Quickmode): 

 
Breezingforms Quick mode is the easiest mode for beginners yet powerful enough for 
advanced users. Combined with a easy to use interface and predefined scripts, it makes 
making forms a breeze. 
 
Getting Started with Forms 
Getting started with forms in QuickMode 

Create Forms - QuickMode 

Using QuickMode, you will be able to create a form quickly and easily. Let's start by walking you step-by-
step through the creation of a simple, one-page job application form. 

To begin, login to your Joomla account and go to Components -> BreezingForms -> Manage Forms. 

 

Once you're on the Manage Forms screen, click on the green QuickMode icon (as circled below). 
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Form Properties 

You will see that the QuickMode screen is comprised of two areas. On the left side, you can add new 
pages, sections and elements, while on the right side you have access to numerous form and element 
properties. 
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 Title 
QuickMode will generate a Title for the form automatically. You can change the title at any time 
under the Form properties. In the example shown above, the form Title is "My First Form." 

 Name 
QuickMode will generate a Name for the form automatically. You can change the name at any 
time under the Form properties. In the example shown above, the form Name is "myfirstform." 
 
Important: The form's "Name" field provides a way to reference the form in a script and in the 
Joomla! component itself. We therefore recommend that you avoid using special characters 
and/or blank spaces in the form name. 

 Description 
Enter a short description about your form. This will appear in your list of forms on the Manage 
Forms screen. 

 Last Page is Thank You Page 
If you check this option, your form page will refresh and the respondent will see a Thank You 
message on the page indicating that their form has been submitted. (If you would like to redirect 
a respondent to a completely different URL, please click here for instructions on how to do that.) 

 Mail Notification 
If you want to send a copy of the form results to an Email address, then please check the box for 
Mail Notification. 
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 Mail Recipient(s) 
If you want to send a copy of the form results to an Email address (or multiple Email 
addresses) other than the default Email address that you entered on the configuration 
form, then enter it here. To enter multiple Email addresses, please use the format below: 
 
EmailAddress1@mycompany.com;EmailAddress2@mycompany.com;EmailAddress3@mycomp
any.com 

 Include Submit Button 
If you want to include a 'Submit' button at the bottom of your form, please choose "Yes" here. (If 
you would prefer to include a 'Submit' button that uses a custom graphic, please click here for 
instructions on how to do so.) 

 Submit Button Label 
If you are using the default 'Submit' button for your form (rather than one using a custom 
graphic), you can choose to label it whatever you want. (e.g. "Send It!" or "Enter Me Now!") To 
change the button's label, just type the alternate text you wish to use in this field. 

 Paging Include 
If your form consists of multiple pages, you can choose to add a 'Next' and/or 'Back' label, as 
applicable, to each page. To do so, choose "Yes" here. If your form is only one page long, you can 
disregard the settings - the labels will only appear on a multi-page form. 

 Include Cancel Button 
If you want to include a 'Cancel' button at the bottom of your form, please choose "Yes" here. (If 
you would prefer to include a 'Cancel' button that uses a custom graphic, please click here for 
instructions on how to do so.) 

 Cancel Button Label 
If you are using the default 'Cancel' button for your form (rather than one using a custom 
graphic), you can choose to label it whatever you want. (e.g. "Cancel" or "Clear Form") To change 
the button's label, just type the alternate text you wish to use in this field. 

 Save Properties 
Once you have filled in the necessary fields on the Properties tab, click the "Save Properties" 
button located at both the top and bottom of the screen. 

 Save Form 
Important: The "Save Properties" button only saves the parameters of the form tab that you are 
on. IT DOES NOT SAVE THE FORM ITSELF. To save the form, click on the "Save" icon in the 
upper right-hand corner of the page. 
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Advanced Form Properties 
Learn more about advanced form properties. 

QuickMode: Advanced Form Properties 

From the Advanced tab, you can define a number of form effects as described below. 

 

Form Options - More Options 

Once you have saved the form, a link to "More Options" will appear where noted on the image above. On 
that screen you will see the following tabs: 

 Settings 
 Scripts 
 Form Pieces 
 Submit Pieces 

  

Other Options 

 Theme 
With BreezingForms versions 1.65 and higher, the ability to select and customize themes for 
forms is now included; however, this feature is only available in QuickMode. Version 1.7.0 of 
QuickMode provides two themes: Qmtheme, which is a clean, light-blue theme; 
and Default, which has no defined colors. Version 1.7.1 has added additional themes. These 
themes can easily be customized via CSS. 
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 Use Alerts on Errors 
If you have set any of your form fields to validate, an error message is generated if a field isn't 
filled in, or is filled in incorrectly. If this field is left unchecked, the error message will appear at 
the top of the form. If you check this field, then an alert will pop up, like this: 

 

 Fading Effect on Form Entry 
If you select this option, your form fields will fade in as the page loads. NOTE: if you are using 
Flash file uploads, this effect should be disabled due to a current bug in the code. (On the list to 
be corrected...) 

 Rollover 
This box is checked by default. When checked, a field will change color when it is moused over. 

 Rollover Color 
If you'd like to change the rollover color, enter the hex code here for your preferred color. Don't 
understand hex codes or know which one you want? Here's a good source for you. 

 Visibility Rules 
In order to turn fields and/or sections on and off conditionally, you need to add your visibility 
rules in this field. For more information about conditional fields and visibility rules, please click 
here. 

 Save Properties 
Once you have filled in the necessary fields on the Properties tab, click the "Save Properties" 
button located at both the top and bottom of the screen. 

 Save Form 
Important: The "Save Properties" button only saves the parameters of the form tab that you are 
on. IT DOES NOT SAVE THE FORM ITSELF. To save the form, click on the "Save" icon in the 
upper right-hand corner of the page. 

  

http://www.2createawebsite.com/build/hex-colors.html
http://www.crosstec.de/turn-fields-and-sections-on-or-off-conditionally.html
http://www.crosstec.de/turn-fields-and-sections-on-or-off-conditionally.html
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Advanced Form Options 
Learn more about advanced form options and settings. 

QuickMode: Form Options - More Options: Settings 

The "Settings" tab carries forward some settings initially defined elsewhere and allows you to change 
them and/or define some additional parameters, such as the order you want the form to appear in, 
whether it will run in the frontend or on the backend (admin) side, and so on. For more information on 
each individual element, please read on. 

 

 Title 
This field will automatically carry forward the title you defined when you created the form. If 
you change it here, then save the settings at the bottom of the page, and then save the form itself, 
your old title will be overwritten with the new one you just defined. 

 Name 
This field will automatically carry forward the form name you defined when you created the 
form. If you change it here, then save the settings at the bottom of the page, and then save the 
form itself, your old form name will be overwritten with the new one you just defined. 

 Ordering 
This dropdown allows you to change the order in which your form appears on the "Manage 
Forms" screen. If you'd like it to appear at the very top of the list, select 0 First. If you'd like it to 
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appear somewhere else on the list, just choose the number that corresponds with the order that 
you want it in. (For example, to have it appear in the third position, choose number 3.) 

 Published 
Select "yes" if the form should be published; "no" if it should not be published yet. 

 Run Mode 
There are three select values for Run Mode, as follows: 

o Any - Form will run on either the frontend or backend (admin) side 
o Frontend - Form will run on the frontend 
o Backend - Form will run on the admin side 

 Width 
The width of your form can be defined in pixels or as a percentage. (By default, it is set at 400 
pixels.) NOTE: This definition only works for forms that will be displayed within an iFrame. To 
set the width of a regular QuickMode form, please see this KnowledgeBase Article: Adjust Form 
Width. 

 Height 
The height of your form must be defined in pixels. Note: Auto and Automax require specification 
of a bottom 'margin' in pixels. The 'margin,' however, is actually defining the form's height in 
pixels, so make sure you leave it high enough to display your entire form. 

 Log to Database 
If you want to retain form entries from your site, BreezingForms gives you the ability to log 
entries to the database. In this field, you can choose from one of three options: 

o No - No entries will be logged 
o Nonempty values - Fields that include data will be recorded 
o All values - All form fields will be logged to the database 

 Email Notification 
This field allows you to choose whether or not you want to receive copies of submitted forms via 
Email. There are three options available: 

o No - Email will not be sent 
o To Default Address - Forms will be sent to the Email address you defined as the default 

in the Configuration section of BreezingForms. If you select this option, you will have 
two other fields to complete: 

 Report - Choose to Email the header only, nonempty values, or all values. 
 FORMS_ATTACHMENT - You can choose whether or not to send the form data 

as an attachment to the Email. If yes, you may choose from one of the following 
formats: XML, CSV, or PDF. 

o To Custom Address - If you specified a different Email address to send the forms to on 
the Form Properties page, it will automatically carry forward to this field. If you hadn't 
previously specified a custom Email address (or addresses) to send the form to, you may 
do so here. For multiple Email addresses, you must use a semicolon (;) to separate them. 
If you select this option, you will have two other fields to complete: 

 Report - Choose to Email the header only, nonempty values, or all values. 
 FORMS_ATTACHMENT - You can choose whether or not to send the form data 

as an attachment to the Email. If yes, you may choose from one of the following 
formats: XML, CSV, or PDF. 

 Custom Mail Subject 
If you would like to include a custom subject in the Email confirmation you are sent, you may do 
so here. 

 Description 
The description field will carry forward the form description that you specified on the Form 
Properties page. If you'd like to change or enhance it, you can do so here. You will see three 
numbers in square brackets beside the Description title. Each one reflects the number of lines to 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=210
http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=210
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be displayed in the text area. If you click on [4], a four-line text area will be displayed. Likewise, 
if you click on [12]or [20], a 12- or 20-line text area will be displayed. 

 Save Settings 
Once you have finished making changes on this screen, you must click on the "SAVE" icon at the 
bottom of the screen. 
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Email Settings in BreezingForms 1.7.3 and Higher 
Changes have been made to the way Emails are handled in BreezingForms 1.7.3. Please see below for 
details. 

  

In previous versions of BreezingForms, some of the settings for Email options determined how Emails 
would be handled for both the Admin emails and the Mailback emails. As of version 1.7.3, this has 
changed. Both functions are now handled in separate screens. 

To work with Email settings, go to your form's properties > Advanced tab > More Options. You will now 
see that there are two new tabs there -- one for Admin Emails and one for Mailback Emails.  

 

ADMIN EMAILS 

 
Click on the Admin Emails tab. You will then see a screen that looks like this: 
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Email Notifications 

There are three options available in this dropdown: 

1. No - will not send an Email to Admin. 

2. To Default Address - will send an Email to the default  Email address specified in BreezingForms' 
configuration. 

3. To Custom Address - will send an Email to the custom Email address that you enter in the "Email to" 
field below the dropdown.(It's probably obvious, but remember to change it from your@email.com to 
the Email address you want the admin Email sent to.)  

  

Report 

In the Admin Email that is sent, you can choose to report (send) the following data: 

1.  Header only - will only send the header data 

2. Nonempty values - will send data from all fields which were completed, but will not send data from 
fields that were left empty. 

3. All values - will send data from all form fields, whether completed or not. 
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Attachment 

You can choose whether to send an attachment with the Admin Email. The options are: 

1. No - do not send attachment 

2. XML - send form data in XML format 

3. CSV - send form data in CSV format 

4. PDF - send form data in PDF format 

  

Alternative From Email / Alternative From Name 

By default, BreezingForms uses the Email address and name defined in your Joomla global configuration 
settings as the 'From' name/address for form emails. There may be times, however, when you want the 
'From'  field to show a different name and/or Email address. If so, you can specify those here. 

  

Custom Email Subject 

If you want the Admin Email to have a custom subject that will appear in every Email sent for this form, 
you can define it in this field. 

  

Edit Emails 

1. Default - uses the default Email template (or custom template if you have created one) as described in 
this section of the KnowledgeBase: 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewcatclient&id=52  

2. Custom - This is a new feature in BreezingForms 1.7.3. You can now create a quick Email template 
using a simple tagging system. When you click on the 'Custom' button, a new section will appear, as 
follows: 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewcatclient&id=52
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Click on one of the bracketed links in the left-hand column, and it will then be displayed in the textbox 
on the right. Within that textbox, you can manipulate the layout as you wish. 
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If you choose the YES button to send as HTML, then you can wrap the labels and values within 
paragraphs, use different fonts and colors, etc. (In fact, if you specify that it should be sent as HTML but 
don't use HTML tags in the message, the Email sent will be displayed without linebreaks or other 
formatting.) 

If you choose the NO button, the Email will be sent in plain-text format, and the layout that you create 
will be retained in the Email, including whatever linebreaks you might include.  

Once you have the layout done the way you want, you can go to the Mailback Email tab to customize 
your settings there. 

TIP: You might want to save your changes before moving on. If so, scroll down to the bottom of the frame 
and click on the SAVE button. You will then be returned to the main form screen. Click the SAVE button in 
the upper right-hand corner of the screen to ensure that your changes are saved. 

  

MAILBACK EMAILS 

The screen for Mailback Emails is almost identical to the one for Admin Emails. The only difference is 
that the Email Address dropdown and "Email To" textfield are not included. 
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Email Notification - Report 

In the Mailback Email that is sent, you can choose to report (send) the following data: 

1.  Header only - will only send the header data 

2. Nonempty values - will send data from all fields which were completed, but will not send data from 
fields that were left empty. 

3. All values - will send data from all form fields, whether completed or not. 

  

Attachment 

You can choose whether to send an attachment with the Mailback Email. The options are: 

1. No - do not send attachment 

2. XML - send form data in XML format 

3. CSV - send form data in CSV format 

4. PDF - send form data in PDF format 
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Alternative From Email / Alternative From Name 

By default, BreezingForms uses the Email address and name defined in your Joomla global configuration 
settings as the 'From' name/address for form emails. There may be times, however, when you want the 
'From'  field to show a different name and/or Email address. If so, you can specify those here. 

  

Custom Email Subject 

If you want the Mailback Email to have a custom subject that will appear in every Email sent for this 
form, you can define it in this field. 

  

Edit Emails 

1. Default - uses the default Email template (or custom template if you have created one) as described in 
this section of the KnowledgeBase: 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewcatclient&id=52  

2. Custom - This is a new feature in BreezingForms 1.7.3. You can now create a quick Email template 
using a simple tagging system. When you click on the 'Custom' button, a new section will appear, as 
follows: 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewcatclient&id=52
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Click on one of the bracketed links in the left-hand column, and it will then be displayed in the textbox 
on the right. Within that textbox, you can manipulate the layout as you wish. 
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If you choose the YES button to send as HTML, then you can wrap the labels and values within 
paragraphs, use different fonts and colors, etc. (In fact, if you specify that it should be sent as HTML but 
don't use HTML tags in the message, the Email sent will be displayed without linebreaks or other 
formatting.) 

If you choose the NO button, the Email will be sent in plain-text format, and the layout that you create 
will be retained in the Email, including whatever linebreaks you might include. 

Once you have made the necessary changes, scroll down to the bottom of the frame and click on 
the SAVE button. You will then be returned to the main form screen. 

Finally, click the SAVE button in the upper right-hand corner of the screen to ensure that your changes 
are saved. 
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Install Additional QuickMode Themes 

  

How do I choose a template for my form? I would like to create a form just like your demo(s): 

After unzipping the main breezingforms_VERSION NUMBER_UNZIP_FIRST.zip file, you will see a folder 
called quickmode_additional_themes. Within it you will find numerous new form themes for QuickMode. 
 
To install a theme for QuickMode, simply login to your site using your FTP client and upload each 
desired folder to /components/com_breezingforms/themes/quickmode/ 
 
The theme(s) will then be accessible in your forms. Open up the form you are working with, and go to 
the Advanced tab. There you will see a dropdown list of available themes. To use the one from that 
example, scroll down to the 'Plastic Light Blue' theme and choose it. Then click the "Save Properties" 
button to save your change to the properties, and finally, click on the SAVE icon in the upper right-hand 
corner of the screen to save the form itself. 

  
Adjust Form Width 

  

How do I adjust the form width in QuickMode? I changed the setting in More Options, but it didn't 
work. 

In the form's properties > Advanced tab > More Options, the form width field there only works for forms 
that are being displayed within an iFrame.  

For a form being displayed normally, the change needs to be made to the CSS file of the form theme that 
you are using. For example if you have assigned the "Aqua" theme to your form, you would have to make 
changes to: 
 
/components/com_breezingforms/themes/quickmode/aqua/theme.css 
 
Around line 27, you should see something like: 

.bfQuickMode { 
  width: 100%; // here you can change the width of the form 
  padding: 0px; 
  margin: 0px; 
}  
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Form Elements 

Checkbox 
How do I set up a Checkbox element? 

To create a checkbox element, use the following settings in the element's properties: 

Type: Checkbox 

Label: Check here to (whatever) - Use whatever wording you want 

Name: checkbox1 (or whatever name you want to assign to it) 

Value: Enter whatever value here that you want to appear in the database and/or email address. Some 
examples: CHECKED - UNCHECKED - AGREED TO TERMS - YES - NO etc. This field MUST have a value 
entered in order to return a result. 

Checked: If you want the box to be checked by default, put a checkmark in the box. 

Readonly: Check this box if you want the field to be read-only. 

Hint: If you feel the element needs a hit / tooltip, enter it here. 

  

VALIDATION SECTION 

If you want the element to be validated, then use the following settings: 

Required: If checked, an asterisk will appear to signify the element is required. (Does not actually 
validate the field. Please see this KnowledgeBase article for more information about validation.) 

Validation: Library 

Error Message: Please check (or uncheck) the checkbox to agree to terms (or whatever you want it to 
say). 

Script: FF::ff_checked (to verify that the checkbox has been checked) 

or 

Script: FF::ff_unchecked (to verify that the checkbox is NOT checked) 

  

http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=103
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Then click on the SAVE PROPERTIES button. 

  

ADVANCED ELEMENT OPTIONS 

There are additional options under the ADVANCED tab, as follows: 

Only send to corresponding mailback field when checked: - Used when checkbox is for a 'Send a 
copy to my Email' request. 

Name of textfield that is marked as mailback: If you are using the checkbox for the 'Send a Copy' 
functionality, then in this field you should enter the NAME (not the label) of the textfield element that 
collects the user's Email address. 

Hide Label: Check this if you want to hide the label assigned in the element's properties screen. 

Logging: Uncheck this field if you do not want to log the value to the database or email. 

Order number: Can be left as it is. 

Tab number: Can be left as it is. 

Turn off: Check this box if you want to hide the element. 

Title position: Choose whether to put the label to the left, right, top or bottom of the checkbox. 

Initscript: By default, set to NONE. 

Actionscript: By default, set to NONE. 

  

REMINDER: Any time you make changes to the settings, remember to click on the SAVE PROPERTIES 
box to save the changes to the element. Then click on the SAVE icon in the upper right-hand corner of 
the screen to save the form itself. 

  

http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=53
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=53
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Checkbox Group 

How do I create a checkbox group? 

  

Checkbox groups are best used when you want to display all the options at one time, and allow the user 
to make multiple choices.  

For a checkbox group, the format to layout the options is as follows: 
 
0;Label;Dabatase Value 
 
or 
 
1;Label;Database Value 
 
If you put a 0 at the front, then the checkbox will be blank. If you put a 1 at the front, then that option 
will, by default, be checked. 
 
For example, if you want to offer a user a choice of one color out of a group, you might code it as follows: 

0;Red;Red 
1;Blue;Blue 
0;Green;Green 
0;I like all colors so it doesn't matter; Any color 

Your options will appear in the list in the same order as you enter them in the 'Group' field. If you want 
to change the order, just move them around within that field. 

You can also choose to check 'Wrap each element,' which would force each choice to a separate line in 
your form.  

IMPORTANT 
The database value (after the second semicolon) must not contain any special characters except for 
underscores, hyphens, or spaces. Use of special characters may cause the form functionality to fail. 
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Password Validation 
How do I make sure that my 'Password' and 'Confirm Password' text fields match? I don't see a 
library script to validate passwords. 

You can create a new library script to handle this type of validation. Here's how: 

1. Go to Components > BreezingForms > Manage Scripts. 

2. Click on the NEW icon in the upper right-hand corner of the screen to create a new script. 

3. On the screen that opens, enter the following variables: 

Title: Validate password repeat 

Published: YES 

Package: FF  

Name: ff_password_repeat 

Type: Element Validation  

Description: Validates that two password fields match. Note: The second password field must be named 
"FIELDNAME_repeat" (where FIELDNAME is the name that you assigned to the first password field). 

4. In the codebox text area, enter the following code: 

Code: 

function ff_password_repeat(element, message) 
{ 
    if ( element.value == "" ){ 
        if (message=='') message = element.name+" is empty.\n"; 
        ff_validationFocus(element.name); 
        return message; 
    } // if 
 
    try{ 
    var repeat = element.name.split("ff_nm_")[1].split("[]")[0]; 
 
    if(!ff_getElementByName(repeat + '_repeat')){ 
      if (message=='') message = repeat+" has no repeat password field.\n"; 
        ff_validationFocus(element.name); 
        return message; 
    } else { 
        if(ff_getElementByName(repeat + '_repeat').value != element.value){ 
           if (message=='') message = element.name+" and " + repeat + "_repeat do not match.\n"; 
           ff_validationFocus(repeat + '_repeat'); 
           return message; 
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        } 
    } 
    }catch(e){ 
        return e.description; 
    } 
 
    return ''; 
} 

 

 
5. Click on the SAVE icon at the bottom of the screen to add the script to your library list. 

6. Now go to your form and create a new element for the user to enter their password into. The element 
should have the following settings: 

Type: Textfield 

Label: Enter Password 

Name: password 

Value, Size, and Max. length fields can be left blank. If you want to add a hint, you can do so in the 'Hint' 
box. 

In the VALIDATION section, enter the following settings: 

Required: Checked (if you want an asterisk * to appear beside the form element) 

Validation Type: Library 

Error Message: Please enter a password. 

Script: FF::ff_password_repeat 

Then click on SAVE PROPERTIES to save the changes you made to the element. 

7. Create a new element for the user to re-enter their password. The element should have the following 
settings: 

Type: Textfield 

Label: Repeat Password 

Name: password_repeat 

Value, Size, and Max. length fields can be left blank. If you want to add a hint, you can do so in the 'Hint' 
box. 
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In the VALIDATION section, enter the following settings: 

Required: Unchecked 

Validation Type: None  

(There is no need to add a validation rule or type to this field because it will be connected automatically 
to the rule in the previous password field. 

Then click on SAVE PROPERTIES to save the changes you made to the element. 
IMPORTANT: If you change the name of the first textfield from "password" to something 
else (let's say, "YourPassword" for example),  then in the second textfield, you will need to 
change the name field to YourPassword_repeat. The word in front of "_repeat" MUST match 
the name given to the first field. 

8. Once the two elements have been added and their properties saved, you now need to save the form 
itself. To do so, click on theSAVE icon in the upper right-hand corner of the screen. 

Then preview your form and test it out! 

 

 

  

Radio Group 

How do I create a radio group? 

  

Radio groups are best used when you want to display all the options at one time, and allow the user to 
select only one of them.  

For a radio group, the format to layout the options is as follows: 

0;Label;Dabatase Value 

 
or 
 

 
1;Label;Database Value 
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If you put a 0 at the front, then the radio button will be blank. If you put a 1 at the front, then that option 
will, by default, be marked as the choice. 
 
For example, if you want to offer a user a choice of one color out of a group, you might code it as follows: 

0;Red;Red 
1;Blue;Blue 
0;Green;Green 
0;I like all colors so it doesn't matter; Any color 

Your options will appear in the list in the same order as you enter them in the 'Group' field. If you want 
to change the order, just move them around within that field. 

You can also choose to check 'Wrap each element,' which would force each choice to a separate line in 
your form.  

IMPORTANT 
The database value (after the second semicolon) must not contain any special characters except for 
underscores, hyphens, or spaces. Use of special characters may cause the form functionality to fail. 

  
 
 

Select-List 
How do I create a Select-List? 

For a select-list, the format to layout the options is as follows: 

0;Label;Dabatase Value 

or 

1;Label;Database Value 

 
If you put a 0 at the front, then the option will not be selected. If you put a 1 at the front, then that option 
will be selected. 
 
If you want to have the first line of a Select-List be something like "Choose Type..." then you would set 
that up like this: 
 
0;Choose Type...; 
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In this case, you will notice that there is no value entered after the second semicolon. That is because, if 
you put a value in it and then use validation rules that state the element is required, any text after that 
second semicolon would make it appear that a choice had been made. If you put no text after the second 
semicolon, then the validation script will still prompt them to select a choice in the field. 
 
So, putting all of that together, let's say you want to give someone a color choice. You might code it as 
follows: 

0;Choose Color; 
0;Red;Red 
0;Blue;Blue 
0;Green;Green 
0;I like all colors so it doesn't matter; Any color 

Your options will appear in the list in the same order as you enter them in the 'List' field. If you want to 
change the order, just move them around within that field. 

The validation rule that should be used with a select-list is FF::ff_valuenotempty. 

 

 

Validating Form Elements 
How do I validate a field? I checked the 'Required' checkbox, but I was able to send a form without 
that field being completed. I don't understand. 

The 'Required' checkbox adds the asterisk ( * ) to the form so there is a visual cue that the field is 
required. However, in order to actually force validation of an element, you must invoke a validation 
script / rule. You do that in the 'Validation' section of a form element: 
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Under most circumstances, you will want to choose a validation rule from the library. To do so, click on 
the 'Library' radio button next to Validation (as shown above). 

Next, enter an error message in the ERROR MESSAGE field. This is the error that will appear to a user if 
the field does not validate. 

Finally, click on the dropdown arrow to choose a script to invoke a validation rule. The scripts / 
validation rules that are installed with BreezingForms include: 

  

  

  

The script to use will depend on the element type. Scripts and validation rules are listed below in 
alphabetical order. 
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FF::ff_anychecked 
Validates that a radio button in selected in a radio group, or that a checkbox has been checked in a 
checkbox group. 

Can be used with the following elements: 

 Radio Group 
 Checkbox Group  

 

FF::ff_checked 
Validates that a radio button or checkbox is checked. 

Can be used with the following elements: 

 Radio Button (when only one in use) 
 Checkbox (when only one in use)  

  

FF::ff_flashupload_not_empty 
Validates that a file is uploaded using the Flash option in the File Upload element. 

Can be used with the following elements: 

 File Upload - with 'Use Flash Upload' checkbox checked in Advanced Properties 

  

FF::ff_integer 
Validates that an integer value is entered. 

Can be used with the following elements: 

 Textfield 
 Hidden Input  

  

FF::ff_integer_or_empty 
Validates that either an integer value or nothing is entered. 

Can be used with the following elements: 

 Textfield 
 Hidden Input  
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FF::ff_integeramount 
Validates that a positive integer value is entered. 

Can be used with the following elements: 

 Textfield 
 Hidden Input  

  

FF::ff_real 
Validates that a real number is entered. 

Can be used with the following elements: 

 Textfield 
 Hidden Input  

  

FF::ff_realamount 
Validates that a positive real number is entered. 

Can be used with the following elements: 

 Textfield 
 Hidden Input  

  

FF::ff_securitycode_entered 
Checks that a security code was entered. 

Not used in QuickMode.  

  

FF::ff_securitycode_ok 
Checks that a valid security code was entered. 

Not used in QuickMode.  

  

FF::ff_showvalidation 
Displays element validation - Used for debugging. 
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Can be used with the following elements: 

 ALL, except Submit Button; Summarize; Captcha; ReCaptcha; PayPal Button; DirectPayment 
Button 

  

FF::ff_unchecked 
Validates that a radio button or checkbox is unchecked. 

Can be used with the following elements: 

 Radio Button (when only one in use) 
 Checkbox (when only one in use)  

  

FF::ff_validemail 
Validates that the syntax for an email address is correct (not the email address itself). 

Can be used with the following elements: 

 Any Textfield that is used to capture an Email address 

  

FF::ff_validemail_repeat 
Checks that the field value is a valid email address (syntax only) and has a second counterpart with an 
equal value. 

Can be used with the following elements: 

 Any Textfield that is used to capture an Email address 

For more information on how this option works, please see this KnowledgeBase article. 

  

FF::ff_valuenotempty 
Validates that the field value is not empty. 

Can be used with the following elements: 

 Textfield 
 Textarea 
 Select-List 
 Hidden Input 
 Calendar 
 Regular Upload Element (Non-Flash) 

http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=21
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Summarize Element 
How do I create a summary for the fields in my form? 

First, make sure that you have PAGING INCLUDE set to "Yes" in the form properties. 
 
To do the summary, create a new page and then for each element you want to add to the summary page, 
you will need to: 
 
1. Add a new element.  
 
2. In the TYPE field, choose SUMMARIZE from the dropdown list.  
 
3. The LABEL can be named the same as the original field.  
 
4. The NAME should be a unique name. You can either leave it with the name automatically assigned by 
the extension, or give it a new unique name not already in use elsewhere on the form. 
 
5. In the CONNECT WITH dropdown, choose the field that you want to pull the summary information 
from. (It will list all of your fields, so it is easy to choose.) 
 
6. Each time you add an element, click on SAVE PROPERTIES. 
 
7. When you are finished adding your summary fields, remember to click the SAVE icon in the upper 
right-hand corner of the screen. 

  
 
PayPal Element 
How do I set up the fields on the PayPal element? 

Please see the attached PDF file which provides step-by-step instructions on how to setup the PayPal 
element for a simple, single button. 

  

IMPORTANT NOTE 
Please note that the thank you page URL for the BreezingForms Version 1.7.1 Build 730 and 
higher should be: 
 
http://www.yourwebsite.com/index.php?option=com_breezingforms&ff_name=YourForm
Name&ff_page=2 
 
NOT 
 
http://www.yourwebsite.com/index.php?option=com_facileforms&ff_name=YourFormNa
me&ff_page=2 
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as noted in this PDF.  

 Conditional Checkbox Validation 
I have three checkboxes in a group. Can I make them dependent on each other so that if checkbox 1 
is checked, you can't check checkbox 2 or 3. If checkbox 2 is checked, you can't check 1 and 3, etc? In 
other words, of the three checkboxes, you can only check one option. 

If it is a case where you only want to allow the user to choose one option out of a group, then you might 
want to use a Radio Group instead of a checkbox group. If there is some other reason why you need 
those checkboxes to be conditional however (for example, for a following visibility rule), then you can do 
so by putting a custom validation in the checkbox group. 

In the Validation section at the bottom of the checkbox element, click on the CUSTOM button. In the 
textarea that opens, paste in the code below. Then make changes as noted in the CHANGES 
REQUIRED section below. 

function ff_mygroup_validation(element, message) 
{ 
   // initial checked states for your box, add more or less, depending on your amount of 
checkboxes of your group 
   // if you have checkboxes that are initially checked, set the corresponding value here to 
"true" 
   var checkedBoxes = [false,false,false]; 
 
   for(var i = 0; i < document.ff_form140.elements.length; i++){ 
     if(document.ff_form140.elements[i].type == "checkbox" && 
document.ff_form140.elements[i].name == "ff_nm_mygroup[]"){ 
       if( document.ff_form140.elements[i].checked ){ 
        checkedBoxes[i] = true; 
       }else{ 
        checkedBoxes[i] = false; 
       } 
     } 
   } 
 
   // the rules apply here 
   // add or remove rule depending on your amount of checkboxes 
   if(checkedBoxes[0] && ( checkedBoxes[1] || checkedBoxes[2] ) ) return 'You can only 
check box 1'; 
   if(checkedBoxes[1] && ( checkedBoxes[0] || checkedBoxes[2] ) ) return 'You can only 
check box 2'; 
   if(checkedBoxes[2] && ( checkedBoxes[0] || checkedBoxes[1] ) ) return 'You can only 
check box 3'; 
 

http://crosstec.de/support/index.php?pid=file&fileid=2541
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   return ''; 
 
} // end validation  

  

CHANGES REQUIRED 

1. Replace all instances of ff_form140 in the code above with the formname of your form. To find the 
formname code, view the form's sourcecode. Then search for this code: 

 

ff_processor.form_id=' 

 

The generated formname will follow immediately after that.  

2. Replace all instances of mygroup in the code above with the name of your checkbox group. (You can 
find the name in the field underneath the LABEL field in the element properties screen.) 
 
3. Also note the instructions included within the comments of the code above. 

 

File Upload - Restrict Allowed Extensions 

Can I restrict the Allowed file extensions that a user can upload? 

You can specified the allowed extensions in the File Upload element. Go to the Advanced tab of the form, 
and in this field: 

Allowed file extensions 
 
you can see that the default allowed extensions are: 
 
zip,rar,pdf,doc,xls,ppt,jpg,jpeg,gif,png 
 
You can modify that as you wish. Just note that you should NOT put a dot (.) before the extension name. 

  
Form Text Won't Save 
I am trying to save text in a page but no matter what I do, it won't save! Why not? This happens 
with sections, too.  
Are you using JCE as your text editor? If so, there is currently a known bug that we are trying to resolve, 
but switching to TinyMCE has worked for the users that have reported the issue to us. 
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When creating text, there are three things that you need to do in order to save it: 
 
1. Click on the SAVE icon at the bottom of the text entry / WYSIWIG screen. 
 
2. Click on the SAVE PROPERTIES button to save the form element. 
 
3. Click on the SAVE icon in the upper right-hand corner of the screen to save the text itself. 

  
 

Is There a Way to Add Text to My Form? 
Is there a way to add text to my form? I don't want to put it in an element, but I need it placed beside 
or underneath it. 

Yes, you can add 'free text' in BreezingForms within a page or a section. 

At the page level, your text would appear above the form. To do so, click on the Page title in the left-hand 
'tree,' and then click on the EDIT link to the right of the word INTRO in the right-hand properties. Within 
the editor that opens, you can add HTML, images, etc. 

To place text elsewhere in the form, create a new section where you want the text to be placed, and then 
click on the EDIT link that will appear in the right-hand element properties. Within the editor that 
opens, you can add HTML, images, etc. 

  

Summarize Elements Are Empty - BUG 
I created summarize elements using the instructions I found in the KnowledgeBase, but when I test 
my page, the summaries are all empty. How can I fix this? 

We have identified a bug where the summarize elements will not be filled in if you have the "Fading 
effect on form entry" selected in the form property's Advanced tab. If you have that box checked, please 
uncheck it and see if that resolves the issue for you.  

If it does not, try copying the elements that contains your summarize elements, and then paste them 
back in again. 

To do so, highlight the element name in the left-hand directory 'tree,' then right-click on it and click on 
COPY. Next, highlight the Page line in the directory tree that contains your summarize elements, right-
click on it and then click on PASTE. 
 
Once you have done that for each element, you need to delete the original elements that you created. 
(They should be the ones at the top of the page. Your copied elements will show up below them.) 

Now open up each of the summarize elements and make sure they are correctly mapped to your original 
elements. Click on SAVE PROPERTIES for any summarize element that you have to change, and then 
click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 
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Section Short-Cut 

If your summarize elements are contained within a section, this becomes much easier. You can then 
highlight the SECTION name in the left-hand directory 'tree,' right-click on it and click on COPY. Next, 
highlight the Page line in the directory tree that contains your summarize elements, right-click on it and 
then click on PASTE. 

Now open up each of the summarize elements and make sure they are correctly mapped to your original 
elements. Click on SAVE PROPERTIES for any summarize element that you have to change, and then 
click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 

 

 Stop User From Entering Spaces in Field 
I have the "Value Not Empty" rule in effect, but some users are entering spaces in the field instead of 
typing a real response, and it is getting past the rule. Is there a way to force them to type something 
other than the spaces? 

Go to Components > BreezingForms > Manage Scripts and then click on the value_notempty script to 
edit it. 
 
Replace this: 

function ff_valuenotempty(element, message) 
{ 
    if (element.value!='') return '';  
    if (message=='') message = "Please enter "+element.name+".\n"; 
    ff_validationFocus(element.name); 
    return message; 
} // ff_valuenotempty 

with this: 

function ff_valuenotempty(element, message) 
{ 
  if ( ff_trim(element.value) ) return ''; 
    if (message=='') message = "Please enter "+element.name+".\n"; 
    ff_validationFocus(element.name); 
    return message; 
} // ff_valuenotempty 

 
 
Then click on the SAVE icon in the lower right-hand corner of the screen. 
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Test it out -- it should work for you now. 

  

Delete an Element 

How do I delete an element in QuickMode?  

Right-click on the element name in the directory 'tree' on the left hand side of the page, and you will see 
three options: Copy / Paste / Delete. Click on "Delete" to remove the element.  
 
This works at both the element and section level. For a section, it is important to note that deleting it will 
also delete ALL ELEMENTS contained within the section. 

Calendar Format in BreezingForms 1.7.5 and Higher 

  

I upgraded to BreezingForms 1.7.5 and now my calendar elements aren't working. Help! 

  

The date format has changed in the new version of BreezingForms because of the way Joomla changed 
the code in their calendar. The correct format to use now is: 
 
%m-%d-%Y 

or 

%m/%d/%Y 

or 

%m.%d.%Y 

or 

%Y-%m-%d 

or 

%Y/%m/%d 

or 

%Y.%m.%d 

or  

%d-%m-%Y 

or 

%d/%m/%Y 

or 

%d.%m.%Y 
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Manage Form (Classic Mode) 
Classic Mode I created for those with a more “technical” background. It allows you to fully 
code and alter the way you want your form displayed without limitations. To view the 
manual for Classic Mode use the link below. 
 

Click Here for Classic Mode 
 

Manage Form (Easy Mode) 
Easy Mode is just as it sounds “easy” with the simplicity of quickmode but a little 
Complexity of Classic Mode. The manual for the Easy Mode is coming out in Manual Version 
1.2 in the very near future. 
 

Scripts & Pieces 

 
- Scripts Tab 

 
==> Initialization Script: A javascript that should be executed on form initalization (=loading) 
 
==> Submitted Script: A javascript that will be triggered after the form has been submitted. 
 
- Form Pieces Tab 
 
==> Before Form: PHP that should be executed before the form is rendered. You can for example print 
something out and it will be displayed on top of the form. 
 
==> After Form: The same like above but will be executed after the form is rendered. So printing will 
happen in the end of the form 
 

- Submit Pieces Tab 

 
==> Before Submit: PHP that will be executed before the form is going to be submitted. You can use this 
for example catching values and prevent storing a submission. 
 
==> After Submit: Same like above, except that it will be executed after a submission has been stored. 
 
All of these tabs above share the same concept: 
 
- Library: You can wether choose a predefined script/piece from the library. While each item of the library 

http://crosstec.de/media/docs/BreezingForms-01.pdf
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can be packaged itself. Means, you can create your own library items and re-use them in other forms. 
 
- Custom: You can add code directly in-place for one of the actions above. For custom scripts it is 
required that you click "create code framework" first in order to have a javascript function skeleton where 
you place your code into, while for pieces you can start writing your custom code without the need to 
create a function. 
 
Things you always want to use in a Piece (PHP): 
 
ff_getSubmit('FIELDNAME') => will return the value of a field 
 
ff_getSubmit('FIELDNAME', FF_ARRAY) => will return the value of a field as array. required if you want 
access to vaues of a group like a checkbox 
 
As soon as you use things like ff_getSubmit() in your piece, put this as first command into your custom 
code: 

$this->execPieceByName('ff_InitLib'); 

 
Things you always want to use in a Script (Javascript): 
 
ff_getElementByName('FIELDNAME') ==> will return the DOM object of the field 
ff_getElementByName('FIELDNAME').value ==> will return the value of that field 
 
The same is applicable for scripts that you use for validations, actions and initializations on field level. 
 
 

Using the Integrator 

Here are some instructions on how to use the BreezingForms integrator. 
The integrator (since 1.5.9 build 700) is a nice way to store the data of your forms into any database 
table of your joomla installation (mostly tables beginning with jos_). 
 
The concept behind it is quite simple: 
 
- If you just want to insert new data you choose the form, the database table where you want to store 
the data, and the fields to copy (for example, for newsletter subscriptions).  
 
- If you need to update existing entries, you will need the information above plus some sort of criteria 
that indicates where to save what and when (For example, community builder personal info 
updates). 
 
But let's start with a simple (insert): 
 
1. In the Integrator screen click "New" in the upper right. 
 
2. Choose a name, select the "SampleContactForm" and as target table "jos_users" and as "type" 
leave "insert".  
 
3. Hit "save" in the upper right. 
 
4. Now a second table appears: "Data Integration" 
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5. As _incoming_ element choose "cf_name (Text)" and as _outgoing_ element choose "name 
(varchar)". 
 
6. Click "add". 
 
7. Then as next choose "cf_email (Text)" and as _outgoing_ element choose "email (varchar)".  
 
8. Click "add". 
 
9. In each of these data integrations you see a link "Code", click on the code for the item "cf_name"! 
 
10. In the appearing box enter this: $value = strtoupper($value); 
 
11. Hit "save" below the codebox. What you have just done is to uppercase the incoming name on a 

form save/data copy  
 
12. Now open the SampleContactForm itself, enter some data and submit. 
 
13. Now go open phpMyAdmin and browse to the "jos_users" table and you will see the new entry.  
 
For updates it is a little bit more difficult. If you need assistance, please contact support. 
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FAQ’s/ Coding Tips and Ideas  

Here is a list of FAQ’s, Ideas and Coding tips you may want to utilize on your next project. 
We try to cover every scenario as best we can. Please remember that that for the Paid or 
free version of Breezing forms the thing that are and are not included: 
 

Included in support: 
Installation help 

General usage help 

 

NOT Included in Support: 
Custom programming 

Consulting 
Fixing of 3rd party caused issues 

 
Sometimes from time to time, we do custom programming and assisting with 3rd party 
issues but they are in no way included within the free or paid subscription or we are 
obligated to provide support for NOT included items.  
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Calculating Checkbox Sums 
How do I get my form to calculate amounts from checkboxes? 

1. Create a form using QuickMode 
 
2: Add your checkbox fields.  
 
3a. Give them whatever LABEL you want, but make sure the NAME is something easy. For this example 
the names are d11, d12, d13, d14, d16, d18 and d1o (that last one is a lowercase letter o for "open", not 
the number zero). 
 
3b: Give them a VALUE that is a dollar value. My values for this example are 35.00, 35.00, 35.00, 35.00, 
45.00, 55.00, and 70.00. 
 
3c: For each checkbox, click on the ADVANCED tab, and create an ACTIONSCRIPT event using CUSTOM, 
and check the action CLICK. In the code framework box put in this: 

Code: 

 
function ff_d11_action(element,action) { 
ff_amountowing_action(element,action); 
} 

 

 
Make sure you change the title to match the NAME of this checkbox. So for box d12 it would look like 
this: 

Code: 

 
function ff_d12_action(element,action) { 
ff_amountowing_action(element,action); 
} 

 

 
and so on. 
Make sure you click SAVE PROPERTIES after each field is created! 
 
4a. Create a text field with the NAME "amountowing" and a VALUE of 0. 
 
4b. On the ADVANCED tab click on READ ONLY so that people can not alter the amount. 
Under the ACTIONSCRIPT set it to CUSTOM. You do not need to click on any of the checkboxes, as this 
script runs from the checkboxes on your form (the ones you created in step 2). 
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4c. In the code framework add this: 

Code: 

 
function ff_amountowing_action(element,action) 
{ 
   ff_getElementByName('amountowing').value = 0; 
   if (ff_getElementByName('d11').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d11').value); 
   } 
   if (ff_getElementByName('d12').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d12').value); 
   } 
   if (ff_getElementByName('d13').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d13').value); 
   } 
   if (ff_getElementByName('d14').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d14').value); 
   } 
   if (ff_getElementByName('d16').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d16').value); 
   } 
   if (ff_getElementByName('d18').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d18').value); 
   } 
   if (ff_getElementByName('d1o').checked) 
   { 
      ff_getElementByName('amountowing').value = Number(ff_getElementByName('amountowing').value) + N
umber(ff_getElementByName('d1o').value); 
   } 
} 

 

 
Note that to see all of that code you may have to scroll across! But you can just copy it and paste it into 
your form's code framework.  
 
4d. Modify that code to replace the names with the ones you used in step 2. If you used my names (d11, 
d12, d13, d14, d16, d18 and d1o) then it will work as is. 
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Now save the properties, save the form, and publish. As you click the checkboxes on and off the amount 
owing will be updated with the correct sums. 

 

Embed Form in Article 

  
How do I embed a form inside an article? 
Before you can embed a form within an article, you need to install the BreezingForms 
plugin, and then enable it in your Joomla application's plugin manager. 
Once enabled, it can be embedded into an article using the syntax described below. 
Note: If the plugin has been enabled and your syntax correctly entered as noted below, but 
your article is still not displaying, you might need to go to Extensions > Plugin Manager > 
BreezingForms and change the "use iFrame" option in the plugin parameters from YES to 
NO (or vice versa). 
  
Build 730 & Higher 
  
Pattern syntax: 
 

{ BreezingForms : 
formname,page,border,urlparams,suffix,AllowFormEdit,RemoveExistingSubmissions } 

 

Note: the variables shown in italics in the syntax above are OPTIONAL. Please see examples 
below for proper use based on your needs.  

 
Parameter description: 
BreezingForms: This tag must be present literally and in exact upper/lowercase. 
formname: The name of the form to include, also in exact upper/lowercase. 
page: The starting page number. Defaults to 1 when omitted. 
border: 0=no border, 1=with border. Defaults to 1 when omitted. 
urlparams: Parameters to pass in URL style (no commas or closing brackets allowed). 
suffix: Suffix appended to all CSS class names in the form. 
AllowFormEdit: 0=no, 1=yes. * See Note Below! * 
RemoveExistingSubmissions: 0=no, 1=yes. * See Note Below! *  
  

* NOTE: In order to use the AllowFormEdit and RemoveExistingSubmissions parameters, 
you must include definitions for ALL of the available parameters. Also, choosing to remove 
existing submissions is NOT recommended, so this setting should be set to 0 in most 
circumstances. 

  
Examples: 
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{ BreezingForms : SampleContactForm } 
{ BreezingForms : MyVeryForm,2 } 
{ BreezingForms : AnotherForm, 1,0,&ff_param_xy=123&ff_param_foo=bar } 
{BreezingForms:testform,,,&ff_param_foo=bar,mysuffix } 

 
Pay attention with the following one. Basically it will work, but when using a WYSIWYG 
editor, it will insert linebreaks as <br/> and the bot will no longer recognize the pattern: 
 

{ 
BreezingForms: 
 
AnotherForm,  
1, 
0, 
&ff_param_xy=123&ff_param_foo=bar 
} 

  
 
 

Populate a Field Based on Prior Element in Form 

Is it possible to populate a field further on in a form from data entered in an earlier field? 

Yes, you can do that.  
 
Go to your form's properties > Advanced tab > More Options > Scripts tab. Click on the CUSTOM radio 
button in the Initialization Script section. After doing so, a new textarea will open up. Click on the words 
"Create code framework." A popup box will open that says: 

Create code framework for init now? 
(Existing code will be appended) 

Click OK. 
 
You should then see text in the textarea that looks something like this: 
 
 

function ff_FormName_init() 
{ 
} // ff_FormName_init 
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Between the curly brackets add this code: 

setInterval('ff_getElementByName("TARGETFIELD").value=ff_getElementByName("ORIGI
NALFIELD").value',500); 

So the end result will look something like this: 

function ff_FormName_init() 
{ 
setInterval('ff_getElementByName("TARGETFIELD").value=ff_getElementByName("ORIGI
NALFIELD").value',500); 
} // ff_FormName_init 

In the code above, change TARGETFIELD to the name (NOT Label) of the element that you want the 
previously-entered data inserted into. Change ORIGINALFIELD to the name (NOT Label) of the element 
that will capture the data initially (the first instance of the element). 
 
Then click the SAVE button at the bottom of the Scripts tab. Once returned to the form, click on 
the SAVE icon in the upper right-hand corner of the screen to save the form itself.  
 
Then test it... it should work! 

 

Does BreezingForms Support Authorize.net? 

I need to use authorize.net for my payment gateway. Does BreezingForms support it? 

Authorize.net is not yet implemented natively in BreezingForms, but it is relatively simple to add it 
yourself by using the "End Submit" piece. Basically, you would pass the necessary form variables to 
authorize.net as described in the Send Field Values to a Different URL Tip. 
 
 
The fields that authorize.net needs are described in their integration documentation. 

 
 

Exception Caught by FacileForms Error 

I am trying to get a form working, but keep getting this error: 
 
*** EXCEPTION CAUGHT BY FACILEFORMS ***  
PHP error level : E_WARNING 
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PHP filename  : /home/*****/public_html/*****/plugins/system/zend/Zend/Loader.php 
PHP linenumber : 146 
Error message  : include_once(Zend/Json/Exceptions.php) [function.include-once]: failed 
to open stream: No such file or directory 

  
This exception is a warning for coding standards in PHP and can be safely disabled in your 
php.ini file. Please change the error reporting in the php.ini to: 
 
error_reporting = E_ALL & ~E_NOTICE & ~E_DEPRECATED 
 
The actual value in your php.ini should be used only for sites in development and not for 
production sites. 
 
 

Euro € symbol in Front of Calculated Amount 
 
I created a form with calculation elements. The calculation elements calculates the value of several 
list elements within a section and present it as a value. So far so good. In the list element I created a 
list (0;09 volw, €2200;2200) so the viewer sees € 2000. But in the calculation field it simply shows 
2000. What do I have to do to show the € sign? Same question if it is a dollar. 

This is my code:  
 
function ff_myanswer_action(element,action)  
{ 
ff_getElementByName('myanswer').value = 0; 
if (ff_getElementByName('cateringvolwassene').value) 
{ 
ff_getElementByName('myanswer').value =  
Number(ff_getElementByName('cateringvolwassene').value) + 
Number(ff_getElementByName('cateringkinderen').value); 
} 
} 
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Please try this instead. Note the Euro symbol in single quotes near the bottom of the code: 

function ff_myanswer_action(element,action) 
{ 
ff_getElementByName('myanswer').value = 0; 
if (ff_getElementByName('cateringvolwassene').value) 
{ 
ff_getElementByName('myanswer').value = 
Number(ff_getElementByName('cateringvolwassene').value) + 
Number(ff_getElementByName('cateringkinderen').value); 
 
ff_getElementByName('myanswer').value ='€'+ff_getElementByName('myanswer').value ;  
} 
} 

 
 

Flash HTTP Error 
When I try to upload a file using the Flash uploader, I get an HTTP error. How can I fix it? 

Flash apparently has a known (but not yet fixed) bug in the Upload header that causes an http error if 
mod_security is enabled. Some articles suggested that adding the following lines to your htaccess file 
may solve it: 

SecFilterEngine Off 
SecFilterScanPOST Off 

HOWEVER, there are some who feel that is a SECURITY RISK, so you should discuss this with your web 
host before implementing any changes. 
 
Here is an article that explains some ways to limit the risks to some extent: 

http://www.askapache.com/htaccess/mod_security-htaccess-tricks.html 

 
 

Calendar: Changing Font Colors 
Is possible to change the faded text for weekends? You can hardly see it! 

Yes, it is. BreezingForms calls the Joomla calendar function into the form. You should find their CSS file 
here:  

http://www.askapache.com/htaccess/mod_security-htaccess-tricks.html
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yourJoomlaRoot/includes/js/calendar/calendar-mos.css 

 
 
And here is the CSS you are looking for: 

Code: 

 
 
.calendar thead .name (line 37) 
{ 
border-bottom-width: 1px; 
border-bottom-style: solid; 
border-bottom-color: #cccccc; 
padding-top: 2px; 
padding-right: 2px; 
padding-bottom: 2px; 
padding-left: 2px; 
text-align: center; 
color: #000000; 
} 
.calendar thead .weekend (line 44) 
{ 
color: #dedede; 
} 

 

 
 
It's the 'weekend' part of that you need to change. 

 
 

Calendar: validating date in the past 
How to command the calendar function to have a warning message when they choose the past date? 

That requires a custom validation for the calendar item (calendar item => validation => click "custom" 
=> click "generate code framework"), Inside the generated function you put this (between { and }) such 
that it looks like this: 
 

function ff_CALENDARITEMNAME_validation(element, message) 
{ 
  if(element.value.split("-").length != 3){return message == '' ? element.name+" faild in my 
test.n" : message} 
 
  var vDate = new Date(element.value.split("-")[0], Number(element.value.split("-")[1])-1, 
element.value.split("-")[2],0,0,0,0).getTime(); 
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  var today = new Date(); 
  today.setHours(0); 
  today.setMinutes(0); 
  today.setSeconds(0); 
  today.setMilliseconds(0); 
  today = today.getTime(); 
 
  if(vDate < today) 
  { 
   if (message=='') message = element.name+" faild in my test.n"; 
   return message;  
  } 
  return ''; 
}  

 
This example is for the js calendar default date pattern (YYYY-MM-DD), therefore the js above might be 
slightly different for other patterns, for instance german. 
 
Also note: CALENDARITEMNAME has to be replaced by your calendar item's name. This is 
automatically done by clicking "Generate Code Framework". 

 
 

Can I Replace or Enhance Joomla's Registration Form? #1 
Can I replace or enhance Joomla's registration form? I need more fields than it offers. 

Yes, you can do that with BreezingForms. 
 
See this package: 

http://crosstec.de/en/markets/breezingforms-form-
apps/details/30/2/breezingforms-market-type-form-apps-user-registration-
form.html 

Then just disable Joomla's registration and connect your new form through menu, article (via plugin) or 
module. 

 

Can I Replace or Enhance Joomla's Registration Form? #2 
Can I replace or enhance Joomla's registration form? I need more information than it asks for. 
Try this End Submit piece - it works really well for me: 

Code: 

http://crosstec.de/en/markets/breezingforms-form-apps/details/30/2/breezingforms-market-type-form-apps-user-registration-form.html
http://crosstec.de/en/markets/breezingforms-form-apps/details/30/2/breezingforms-market-type-form-apps-user-registration-form.html
http://crosstec.de/en/markets/breezingforms-form-apps/details/30/2/breezingforms-market-type-form-apps-user-registration-form.html
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// Begin create user 
global $mainframe; 
                JFactory::getLanguage()->load('com_user'); 
                $this->execPieceByName('ff_InitLib'); 
$user  = clone(JFactory::getUser()); 
$pathway  =& $mainframe->getPathway(); 
$config =& JFactory::getConfig(); 
$authorize =& JFactory::getACL(); 
$document   =& JFactory::getDocument(); 
 
// If user registration is not allowed, show 403 not authorized. 
$usersConfig = &JComponentHelper::getParams( 'com_users' ); 
if ($usersConfig->get('allowUserRegistration') == '0') { 
echo '<script>alert("Access forbidden");history.go(-1);</script>'; 
return; 
} else { 
 
// Initialize new usertype setting 
$newUsertype = $usersConfig->get( 'new_usertype' ); 
if (!$newUsertype) { 
$newUsertype = 'Registered'; 
} 
 
// Bind the post array to the user object 
$post = array( 
'name' => ff_getSubmit('name'),  
'username' => ff_getSubmit('email'),  
'email' => ff_getSubmit('email'),  
'password' => ff_getSubmit('bfSubsPassword'),  
'password2' => ff_getSubmit('bfSubsPassword'),  
'task' => 'register_save', 
  'id' => '0', 
  'gid' => '0', 
); 
 
if (!$user->bind( $post, 'usertype' )) { 
echo '<script>alert("'.addslashes($user->getError()).'");history.go(-1);</script>'; 
return; 
} else { 
 
// Set some initial user values 
$user->set('id', 0); 
$user->set('usertype', ''); 
$user->set('gid', $authorize->get_group_id( '', $newUsertype, 'ARO' )); 
 
$date =& JFactory::getDate(); 
$user->set('registerDate', $date->toMySQL()); 
 
// If user activation is turned on, we need to set the activation information 
$useractivation = $usersConfig->get( 'useractivation' ); 
if ($useractivation == '1') 
{ 
jimport('joomla.user.helper'); 
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$user->set('activation', JUtility::getHash( JUserHelper::genRandomPassword()) ); 
$user->set('block', '1'); 
} 
 
// If there was an error with registration, set the message and display form 
if ( !$user->save() ) 
{ 
echo '<script>alert("'.addslashes(JText::_( $user->getError())).'");history.go(-1);</script>'; 
return; 
} else { 
 
$db =& JFactory::getDBO(); 
 
$name  = $user->get('name'); 
$email  = $user->get('email'); 
$username  = $user->get('username'); 
 
JFactory::getDBO()->setQuery("Update #__facileforms_records Set user_id = '".$user->get('id')."',  
 
username = ".JFactory::getDBO()->Quote($username).", user_full_name = ".JFactory::getDBO()-
>Quote($name)." Where id = '".$this->record_id."'"); 
JFactory::getDBO()->query(); 
} 
 
} 
 
} 
// End create user 

 

Captcha: Change Colors, etc. 

Can I change the background color of the captcha?  

Yes, you can. You can make a number of changes to the captcha settings here: 

In Build 730 and higher: 

/components/com_breezingforms/images/captcha/securimage_show.php 

Creating a Two-Column Form 
I need a form with two columns. Can you tell me how to do that? 
Highlight the page in the form tree on the left-hand side of the page. Click on the NEW SECTION button 
and set the properties as follows: 
 
Type: Normal 
 
Display Type: All in a Row 
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Title: Section 1 (Rename as you see fit - this is for illustration purposes) 
 
Section Name: You can name this yourself or leave it with the name automatically assigned by 
BreezingForms. Note that if you rename it, that the name should include only letters, numbers and 
underscores. Special characters and spaces should NOT be used. 
 
Now highlight the Section 1 that you just created, and click on the NEW SECTION button again. This 
time, set the properties to: 
 
Type: Fieldset 
 
Display Type: Wrap after each element 
 
Title: Section 1A  (Rename as you see fit - this is for illustration purposes) 
 
Section Name: You can name this yourself or leave it with the name automatically assigned by 
BreezingForms. Note that if you rename it, that the name should include only letters, numbers and 
underscores. Special characters and spaces should NOT be used. 
 
Once again, highlight the Section 1 that you just created, and click on the NEW SECTION button again. 
This time, set the properties to: 
 
Type: Fieldset 
 
Display Type: Wrap after each element 
 
Title: Section 1B  (Rename as you see fit - this is for illustration purposes) 
 
Section Name: You can name this yourself or leave it with the name automatically assigned by 
BreezingForms. Note that if you rename it, that the name should include only letters, numbers and 
underscores. Special characters and spaces should NOT be used. 
 
Within each of those sub-sections (1A and 1B), you would then put the elements that you want 
displayed within the fieldset. 
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Captcha: Change Colors, etc. 

  

Can I change the background color of the captcha?  

Yes, you can. You can make a number of changes to the captcha settings here: 

In Build 730 and higher: 

/components/com_breezingforms/images/captcha/securimage_show.php 

  

In Build 729 and lower:  

/components/com_facileforms/images/captcha/securimage_show.php 

 
 

Creating a Two-Column Form 
I need a form with two columns. Can you tell me how to do that? 
Highlight the page in the form tree on the left-hand side of the page. Click on the NEW SECTION button 
and set the properties as follows: 
 
Type: Normal 
 
Display Type: All in a Row 
 
Title: Section 1 (Rename as you see fit - this is for illustration purposes) 
 
Section Name: You can name this yourself or leave it with the name automatically assigned by 
BreezingForms. Note that if you rename it, that the name should include only letters, numbers and 
underscores. Special characters and spaces should NOT be used. 
 
Now highlight the Section 1 that you just created, and click on the NEW SECTION button again. This 
time, set the properties to: 
 
Type: Fieldset 
 
Display Type: Wrap after each element 
 
Title: Section 1A  (Rename as you see fit - this is for illustration purposes) 
 
Section Name: You can name this yourself or leave it with the name automatically assigned by 
BreezingForms. Note that if you rename it, that the name should include only letters, numbers and 
underscores. Special characters and spaces should NOT be used. 
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Once again, highlight the Section 1 that you just created, and click on the NEW SECTION button again. 
This time, set the properties to: 
 
Type: Fieldset 
 
Display Type: Wrap after each element 
 
Title: Section 1B  (Rename as you see fit - this is for illustration purposes) 
 
Section Name: You can name this yourself or leave it with the name automatically assigned by 
BreezingForms. Note that if you rename it, that the name should include only letters, numbers and 
underscores. Special characters and spaces should NOT be used. 
 
Within each of those sub-sections (1A and 1B), you would then put the elements that you want 
displayed within the fieldset. 

 
 

How Does the "Confirm Email" Function Work? 
I am trying to use the 'Confirm Email' function, but I can't get it to work! What am I doing wrong?? 

Create your first textfield with these settings: 

TYPE: Textfield 

LABEL: Email 

NAME: email 

The remaining fields (Value, Size, Max. length and hint) are optional. 

In the Validation section at the bottom, put a checkmark in the REQUIRED checkbox. 

Then, in the Validation type, choose the LIBRARY button. In the dropdown list that appears, select 
FF::ff_validemail_repeat. 

 
Now create your second textfield with these settings:  

TYPE: Textfield 

LABEL: Repeat Email 

NAME: email_repeat 

The remaining fields (Value, Size, Max. length and hint) are optional. 

Leave the Validation section at the bottom UNCHECKED. 



[User Guide]  [Crosstec/Breezing Forms] 

Page 92 

There is no need to add a validation rule or type to this Email field because it will automatically be 
connected to the rule in the previous field. 

IMPORTANT NOTE: If you change the name of the first textfield from "email" to something else (let's say, 
"contact" for example),  then in the second textfield, you will need to change the name field to 
contact_repeat. The word in front of "_repeat" MUST match the name given to the first field. 

 
 
 

Height of Textareas 
It seems the height of textareas is ignored. I tried to set my textarea to 5 rows, but nothing happens. 
It still shows 3 rows. How do I fix it? 
 

Use values like 100px or 50%, as you would in CSS. 
 
 
 

Limiting the Number of Characters in a Field to an Exact Amount 
Do you know how I can make the phone number required 10 digits? If possible I want the visitor to 
be able to only enter 10 digits in the phone number field or the form cannot be submitted. 

It definitely is possible to require the phone number field to be ten digits. Here is how to do it: 

 Go to your form, and then to the text element that you are using for your Telephone field. To 
work for this example, it would be best if you give the element the name "telephone" (without 
quotes) in the field underneath the "Label" field. 

 Put a checkmark in the Validation box, and then click on the radio button to the right of the word 
'Custom' in the next line. 

 Enter an error message (for example: "Please enter a valid 10-digit number without dashes, 
periods, or brackets"). 

 Click on "Create code framework." (It doesn't look like a link, but it is!) 
 A javascript popup will appear which says: "Create code framework for validation now? 

(Existing code will be appended)." Click on OK. 
 In the text area that opens, delete all of the code which is currently there, and replace it with: 

function ff_telephone_validation(element, message) 
 { 
  if(!isNaN(element.value) && element.value.length == 10){ 
   return ''; 
  } 
  return 'Please enter a valid number (exactly 10 digits)'; 
 } // ff_telephone_validation 
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 Click on SAVE PROPERTIES. 
 Click on the SAVE icon in the upper right-hand corner of the screen. 
 Test your form. It should work. :-) 

 

 

How To Create a Form Summary 
How do I create a summary for the fields in my form? 
First, make sure that you have PAGING INCLUDE set to "Yes" in the form properties. 
 
To do the summary, create a new page and then for each element you want to add to the summary page, 
you will need to: 
 
1. Add a new element.  
 
2. In the TYPE field, choose SUMMARIZE from the dropdown list.  
 
3. The LABEL can be named the same as the original field.  
 
4. The NAME should be a unique name. You can either leave it with the name automatically assigned by 
the extension, or give it a new unique name not already in use elsewhere on the form. 
 
5. In the CONNECT WITH dropdown, choose the field that you want to pull the summary information 
from. (It will list all of your fields, so it is easy to choose.) 
 
6. Each time you add an element, click on SAVE PROPERTIES. 
 
7. When you are finished adding your summary fields, remember to click the SAVE icon in the upper 
right-hand corner of the screen. 

 

 

 

Step 2 Loop on Installation 

After installing the component I am stuck in step 2, whatever I do it keeps bringing back that step 
and I am in kind of a loop. 

That's a permission issue. Please create an empty file on your computer called "facileforms.config.php". 
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Build 730 & Higher 

Upload this file using your FTP client to: 

/components/com_breezingforms/ 

 

Prefilled form data (name and email) 
For all my forms I am wanting to automatically fill in the name and email 
fields with those of the currently logged in user 
 

QUICKMODE 

You can apply php in your fields directly. So just add this into the "value" of your textfield that is 
supposed to be the name: 

<?php return JFactory::getUser()->get('name'); ?> 

and for the email field value: 

<?php return JFactory::getUser()->get('email'); ?>  

====================================================  

USER TIP FROM BOB R: 

If Joomla's email cloaking plugin is enabled, you will get a nice long javascript instead of an email 
address. Adding the { emailcloak=off } (without the spaces of course) just before the PHP call in the 
value field will solve this problem for the entire form. In fact, if placed anywhere in the form, it will 
disable email cloaking for the entire page. 
 
So what I've done is simply put the following line in my first email form value. 

{emailcloak=off}<?php return JFactory::getUser()->get('email'); ?>  

==================================================== 

EASYMODE 

With EasyMode forms, the PHP code is different, and has to be entered in the Form Settings > Scripts > 
Init Scripts section. Here is an example of what you would need to enter: 
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<?php 
echo ' 
var _name = "'.JFactory::getUser()->get('name').'"; 
var _email = "'.JFactory::getUser()->get('email').'" 
var _username = "'.JFactory::getUser()->get('username').'" 
'; 
?> 
function ff_YourFormName_init() 
{ 
ff_getElementByName('name').value = _name; 
ff_getElementByName('email').value = _email; 
ff_getElementByName('username').value = _username; 
} // ff_YourFormName_init 

Make sure you change the YourFormName part of the code above to the actual name of your form. 

 

URL for Thank You Page 
How do I make my form redirect to a thank you page at a different URL instead of using the thank 
you page that the form creates? 

Create an END SUBMIT piece. 

Form Properties > Advanced Tab > More Options > Submit Pieces Tab 

Then click on "CUSTOM" in the END SUBMIT section and paste in the following code:  

$this->execPieceByName('ff_InitLib'); 
ff_redirect('/myThankYouPage.php'); 
If you are redirecting to a page outside of your server, then it should be coded like this: 
$this->execPieceByName('ff_InitLib'); 
ff_redirect('http://www.yourDomain.com/page.html'); 
If your form is displayed in an iFrame and you want the page you are redirecting to, to 
break out of the iFrame and appear in the main window, use this code instead: 
$this->execPieceByName('ff_InitLib'); 
ff_redirect('/myThankYouPage.php', 'parent'); 

  

or, if redirecting to a page outside of your server: 
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$this->execPieceByName('ff_InitLib'); 
ff_redirect('http://www.yourDomain.com/page.html', 'parent'); 

(Remember to replace the /myThankYouPage.php or http://www.yourDomain.com/page.html with the 
correct URL for your thank you page!) 

Once you have added that code, click on the SAVE button at the bottom of that screen.  You will then be 
taken back to the form's property screen. Click on SAVE PROPERTIES to save the changes to the form's 
properties, and then click on the SAVE icon in the upper right-hand corner of the screen to save the form 
itself. 

 

Changing Fonts in Forms 

How do I change the fonts in my forms? 

Make a new template which you can adjust as you please. To do so, go to your templates folder: 

In Build 730 and higher: 

components/com_breezingforms/themes/quickmode/  

 
Make a copy of the /default folder and paste it back in with a new foldername (i.e. mytheme). 
 
Open the theme.css file in your new folder. You will see that each of the CSS elements is laid out and 
ready for whatever changes you want to make to fonts, colors, etc. For example,if you wanted the text to 
be in Comic Sans MS, here is the CSS you would need to adjust to accomplish that: 

.bfQuickMode { 
font-family: Comic Sans MS; 
font-weight: bold; 
font-size: 20px; 
} 

Once you've made the necessary changes, save the CSS file and reupload it your new mytheme folder. 
Then, in the form properties, select "mytheme" from the Theme dropdown list. 

 

CSS for iFrames 
Can I use CSS in a form that is running in an iFrame? 
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Yes, you can. This forum post offers one possible solution: 

http://www.crosstec.de/forums.html?func=view&catid=5&id=6825#6830 

You could also echo the link rel inclusion as a BEFORE FORM piece. 

Form Properties > Advanced Tab > More Options Link > Form Pieces 

Then in the BEFORE FORM section, click on the CUSTOM button and add the following code: 

$this->execPieceByName('ff_InitLib'); 
 
echo '<link rel="stylesheet" type="text/css" media="all" 
href="'.JURI::root().'path/to/stylesheet.css">'; 

Then click on the SAVE icon at the bottom of that screen, and then, once back at the form properties 
screen, click on the SAVE icon in the upper right-hand corner of the screen.  

 

iFrame Text is Aligned Right 
I have a form running inside an iFrame, but for some reason, the text is all aligned on the right-
hand side and the punctuation shows before the text. Help!! 

This is a known Joomla 1.5.15 bug.  

Look in your Joomla directory structure and see if you have this file: 
 
templates/system/css/template_rtl.css 
 
If so, try replacing the file with an empty one (or comment out the appropriate code as noted in the post 
below). 

http://forum.joomla.org/viewtopic.php?f=430&t=463851&start=0 

That should solve your problem. 

 

Installation: 2006 Error 
I tried to install BreezingForms but I got this error: "component Installer: DB function failed with 
error number 2006" 
There are two possibilities: 

http://www.crosstec.de/forums.html?func=view&catid=5&id=6825#6830
http://forum.joomla.org/viewtopic.php?f=430&t=463851&start=0


[User Guide]  [Crosstec/Breezing Forms] 

Page 98 

One is that you could need to increase the max allowed package size in the mysql config. 

If that doesn't work: 

1. Download the attached file  (bf-components-737.zip) 

2. Unzip the file. (There is just one .sql file in the package.) 

3. BACKUP YOUR DATABASE. 

4. Import the .sql file into your database. If your database prefix is something other than Joomla's default 
jos_ prefix, you will need to change that in the SQL file before importing it. 

5. Download the latest Upgrade version of BreezingForms via the "My Files" link at crosstec.de and 
upload the files/folders to your server as noted in the ReadMe included with the upgrade zip file.  

5. Once complete, go to your Joomla administration, to Components > BreezingForms > Configuration. 
You should now see the Step Two Installation screen. 

6. If this is an upgrade from a previous version, choose the option to keep exisiting tables. If it is a NEW 
installation, choose the option to create tables. 

7. Click CONTINUE to finalize the component installation. (You can then optionally install the module 
and plugin.)  

Click Here to download 

http://crosstec.de/support/index.php?pid=file&fileid=3552
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Create Thank You Page 

How do I make a thank you page in my form? 

For your QuickMode forms, please follow the steps below. 

1. Open your form. On the right-hand side you will see the form properties.  
 
2. Within the form properties, put a checkmark in the box that says "Last page is thank you page." 
 
3. "Include submit button" radio button should be set to YES. 
 
4. "Paging include" should be set to YES. 
 
5. Click on the SAVE PROPERTIES button. 
 
6. Now create a new page (Page 2) 
 
7. Click on the EDIT link under the page properties (beside 'intro'). On that page, you can include HTML, 
images, etc. So add the text/images that you want, and then click on the SAVE button at the bottom of the 
screen. 
 
8. Click on the SAVE PROPERTIES button. 
 
9. Click on the SAVE icon in the upper right-hand corner of the screen. 
 
You do not need to add any special coding or scripts. The form should progress from the first page to the 
thank you page on a successful submit. 

 

FROM Field Displayed as Submitter Name & Email Address 
How do I change the form so that the Email's FROM field shows the name and Email address of the 
person who submitted the form? 

IF YOUR NAME FIELD IS CONTAINED WITHIN ONE FIELD  

 
1. In your form's properties, make sure that the "Mail Notification" checkbox is UNCHECKED. 

2. Copy the code below. 
 
global $mosConfig_mailfrom, $mosConfig_fromname, $my; 
$this->execPieceByName('ff_InitLib'); 
$from = ff_getSubmit('email'); 
$fromname = ff_getSubmit('name'); 
$recipient = 'your@email.com'; // Change to Your Admin Email Address 
 
// Create the Body format for use in e-mail 
foreach ($this->maildata as $data) { 
     if ($data[_FF_DATA_TYPE] != 'Hidden Input') { 
          $body .= $data[_FF_DATA_TITLE].": ".$data[_FF_DATA_VALUE].nl(); 
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     } 
} 
 
$this->sendMail($from, $fromname, $recipient, $body);  // This line actually emails the form. 

3. Make Changes to the Code as Needed - IMPORTANT! 
 
The above code assumes that the "Name" element on the form is actually called "name" (minus the 
quotes) in the NAME field underneath the label, and that the "Email" element on the form is actually 
called "email" (minus the quotes) in the NAME field underneath that element's label. Also, remember to 
change 'youradminemail@yourdomain.com' in the last line of code to your actual admin email address. 
 
4. Once you have edited and copied the code, go to Form Properties > Advanced Tab, and click on the 
"More Options" link.  
 
5. Go to the SUBMIT PIECES tab, to the END SUBMIT section, and click on the CUSTOM radio button. That 
will open a text area into which you should paste the code that you just edited and copied.  
 
6. Click on the SAVE icon at the bottom of that screen to save the code you just added. 
 
7. Once back at the base page of your form, click on the SAVE icon in the upper right-hand corner of the 
screen to save the form itself.  
 
8. Test your form to see if it works. 
 
 
IF YOUR NAME FIELD IS SPLIT INTO FIRST NAME AND LAST NAME 
 
If you have your name field separated into two fields - first and last name - then the code will need to be 
adjusted slightly. In that case, use the following: 
1. In your form's properties, make sure that the "Mail Notification" checkbox is UNCHECKED. 

2. Copy the code below.  

global $mosConfig_mailfrom, $mosConfig_fromname, $my; 

$this->execPieceByName('ff_InitLib'); 

$from = ff_getSubmit('email'); 

$fromname = ff_getSubmit('fname').' '.ff_getSubmit('lname'); 

$recipient = 'your@email.com'; // Change to Your Admin Email 

Address 

 

// Create the Body format for use in e-mail 

foreach ($this->maildata as $data) { 

     if ($data[_FF_DATA_TYPE] != 'Hidden Input') { 

          $body .= $data[_FF_DATA_TITLE].": 

".$data[_FF_DATA_VALUE].nl(); 

     } 

} 
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$this->sendMail($from, $fromname, $recipient, $body);  // This 

line actually emails the form. 

 
 
3. Make Changes to the Code as Needed - IMPORTANT! 
 
The above code assumes that the "First Name" element on the form is actually called "fname" (minus the 
quotes) in the NAME field underneath the label, and that the "Last Name" element on the form is actually 
called "lname" (minus the quotes) in the NAME field underneath the label. Also, remember to change 
'youradminemail@yourdomain.com' in the last line of code to your actual admin email address. 
 
4. Once you have edited and copied the code, go to Form Properties > Advanced Tab, and click on the 
"More Options" link.  
 
5. Go to the SUBMIT PIECES tab, to the END SUBMIT section, and click on the CUSTOM radio button. That 
will open a text area into which you should paste the code that you just edited and copied.  
 
6. Click on the SAVE icon at the bottom of that screen to save the code you just added. 
 
7. Once back at the base page of your form, click on the SAVE icon in the upper right-hand corner of the 
screen to save the form itself.  
 
8. Test your form to see if it works. 

I like this, but I want to send my form to multiple Admin emails. Can I do that? 

  

Yes, you can. Just replace the last line of code with: 

$this->sendMail($from, $fromname, "yourAdmin1@email.com", 

$subject, $body);  // This line actually emails the form. 

$this->sendMail($from, $fromname, "yourAdmin2@email.com", 

$subject, $body);  // This line actually emails the form. 

$this->sendMail($from, $fromname, "yourAdmin3@email.com", 

$subject, $body);  // This line actually emails the form. 

(Can be added as many times as needed -- one for each Email address you need to send out.) 

 

 

File Upload Timestamp Fix 

When files are being uploaded, the timestamp appears in the extension. Is there a way to 
make it appear before the filename instead? 
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This code will add the date before the filename and keeps the extension intact. 
 
In Build 730 and higher, open the following file: 

 

/components/com_breezingforms/facileforms.process.php 

  

Look for: 
 
line 3821 (normal upload) 

      $path = $baseDir.'/'.$userfile_name; 

      if ($timestamp) $path .= '.'.date('YmdHis'); 

      if (file_exists($path)) { 

            $rnd = md5( mt_rand(0, mt_getrandmax()) ); 

            $path = $baseDir.'/'.$rnd.'_'.$userfile_name; 

            if ($timestamp) $path .= '.'.date('YmdHis'); 

            if (file_exists($path)) { 

                  $this->status = _FF_STATUS_UPLOAD_FAILED; 

                  $this->message = 

BFText::_('PROCESS_FILEEXISTS'); 

                  return ''; 

            } 

      } // if 

 

Replace it with: 

if ($timestamp) $time_path = date('YmdHis')."_"; 

      $path = $baseDir.'/'.$time_path.$userfile_name; 

      if (file_exists($path)) { 

            $this->status = _FF_STATUS_UPLOAD_FAILED; 

            $this->message = BFText::_('PROCESS_FILEEXISTS'); 

       return ''; 

      } // if 

 

Next, find: 
 
line 3916 (flash upload) 



[User Guide]  [Crosstec/Breezing Forms] 

Page 103 

    $path = $baseDir.'/'.$userfile_name; 

    if ($row->flag1) $path .= '.'.date('YmdHis'); 

    if (file_exists($path)) { 

          $rnd = md5( mt_rand(0, mt_getrandmax()) ); 

          $path = $baseDir.'/'.$rnd.'_'.$userfile_name; 

          if ($row->flag1) $path .= '.'.date('YmdHis'); 

          if (file_exists($path)) { 

                $this->status = _FF_STATUS_UPLOAD_FAILED; 

                $this->message = 

BFText::_('PROCESS_FILEEXISTS'); 

                return ''; 

          } 

    } // if 

 

 
 
Replace it with: 

    if ($row->flag1) $time_path = date('YmdHis')."_"; 

          $path = $baseDir.'/'.$time_path.$userfile_name; 

          if (file_exists($path)) { 

                $this->status = _FF_STATUS_UPLOAD_FAILED; 

                $this->message = 

BFText::_('PROCESS_FILEEXISTS'); 

           return ''; 

    } // if 

Thanks to Stefan Mortelmans for contributing the code! 

 

Next Page Doesn't Go to the Top of the Page 

When I click on the "next page" button, it doesn't return to the top of the page. How can I fix it 
so it does? 

1. Go to Components > BreezingForms > Manage Scripts. 

Click on Validate and Next Page. Add self.scrollTo(0,0); at the bottom of the function, just before 
the } // ff_validate_nextpage line. 
 
The script should now look like this.  

Code: 
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function ff_validate_nextpage(element, action) 

{ 

    if(typeof bfUseErrorAlerts != 'undefined'){ 

     $jq(".bfErrorMessage").html(''); 

     $jq(".bfErrorMessage").css("display","none"); 

    } 

 

    error = ff_validation(ff_currentpage); 

    if (error != '') { 

       if(typeof bfUseErrorAlerts == 'undefined'){ 

           alert(error); 

        } else { 

           bfShowErrors(error); 

        } 

        ff_validationFocus(''); 

    } else 

        ff_switchpage(ff_currentpage+1); 

        self.scrollTo(0,0); 

} // ff_validate_nextpage 

 

You might want to make the same change to other scripts that provide page navigation, such as: 

- Next Page (ff_nextpage) 

- Previous Page (ff_previouspage) 

 

White Screen - How to Fix? 

When I try to submit my forms, I get a white screen on the front end. How do I fix it? 

Here is some potential solutions to this issue: 
 
1. The RokCandy macro component messes up other components unless you go into the 
Component>RokCandy settings and turn off all of the "Basic" macros (there are about 6 of them). 
You can leave all the special template overrides active as they only apply to the RT templates and 
don't muck with anything else. Once I did this, I was able to see my forms without any problem. 
 
(Thanks to Kelly for sharing your solution!) 

  

__________________________________________________________________ 

2. If your site is hosted with one.com: 
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Since One.com upgraded PHP, we have been getting a white screen. I found a working solution. If 
you are having this problem and One.com is your webhost, try configuring the Joomla e-mail settings 
as follows: 

Mailer: SMTP-Server 

Email: your@email.com (replace this with your Email address) 

From: name of the website (the name you want in the FROM field) 

Sendmail pad: /usr/sbin/sendmail 

SMTP authentication: No 

SMTP security: none 

SMTP port: 25 

SMTP username: empty 

SMTP password: empty 

SMTP host: mailout.one.com 

(Thanks to Erik for sharing your solution!) 

 

Select-Lists for Email to Different Addresses 

Is it possible to send emails to different departments, depending on what a user selects? 

Yes, it is. 

In QuickMode, in the Select-List element's Advanced tab, there is a "Mailback" checkbox. If you 
check it, the values of your select-list items will be used as Email addresses to send the "Form 
record received" Email. 
 
The List would look something like this: 

0;Bug;bugs@yourcompany.com 

0;Information;info@yourcompany.com 

0;Sales;sales@yourcompany.com 

If you have an email cloaking plugin, make sure that you put it BELOW the BreezingForms plugin, 
otherwise it might not work correctly. 

How to Display the Form in Your Site 

Okay, I've created the form. Now what? How do I make it show up on my site? 

There are three ways to get the forms onto a page: 
 
1. Link directly to the form via the Menu. Click on Menus > Main Menu (or whichever menu you want 
it in), and then click on New. Choose BreezingForms as the menu type, and then click on 'Add a 
Form' when it appears. You will then be taken to the regular menu item screen. 
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In the parameters section, enter the form name EXACTLY AS SHOWN (including case sensitivity) in 
the NAME column on the Manage Forms screen. Fill in the other details as necessary, and then click 
SAVE. 
 
2. Install and enable the BreezingForms plugin and embed the form within an article. For instructions 
on how to do that, see: 

Install Plugin: 
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=23 

Embed Form in Article: 
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=74  

3. Display the form in a module position. To do so, install and enable the BreezingForms module, 
then go to Extensions > Module Manager and click on NEW. Select "BreezingForms" and then click 
next. Then, in the parameters section, enter the form name EXACTLY AS SHOWN (including case 
sensitivity) in the NAME column on the Manage Forms screen. Fill in the other details as necessary, 
and then click SAVE. 

 

How to Use Submit Button 

How do I get the Submit button to work in a QuickMode form? 
If you are using QuickMode, and your submit button is simply to advance the form to the thank you 
page and submit the data from the form, then all you need to do is: 
 
1. In the form properties, check the box that says "Last page is thank you page." 
 
2. Make sure the button for "Include submit button" is set to YES. 
 
3. Make sure that the button for "Paging include" is set to YES. 
 
4. Click on the SAVE PROPERTIES button on the Form Properties screen to save the changes you 
just made to the form properties. (It appears both above and below the entry screen.) 
 
5. Add whatever form elements you need into the first page of the form.  
 
5. Create a new Page (Page 2) and enter a Thank You message in the Description. (You can access 
it via the EDIT link next to Description.) You can use HTML, images, etc. in this field. Then click 
SAVE PROPERTIES to save the element text. 
 
6. Click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 
 
7. Test the form -- it should now work. 

 

Populate Fields from Database Table 

Is there a way to populate fields from a database table? 

http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=23
http://www.crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=74%20
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(Contributed by Erich Haubrich)  

I looked around for a way to populate fields in a form from the database if a user is logged in. I 
hacked together a few pieces of code and came up with this. IT WORKS! - Note: I am using it in 
Quick Mode. 
 
In this case, the table that I'm pulling from has the user's email address in it - this grabs the email 
address of the current user and finds that email in the table I am querying, then populates the field 
values of the form. 
 
I am using it to populate the mobile phone and home phone of the user in a contact form. 
 
Before Form Piece 

// Get the lead info fo the current user 

$this->execPieceByName('ff_InitLib'); 

global $database, $record, $my; 

$id = $my->email;  

$database->setQuery(" 

SELECT *  

FROM jos_[your_table_name] 

WHERE email = '$id'" 

); 

$row = $database->loadObjectList(); 

$record = $row[0]; 

 
 
FORM VALUES: 

Name: 

<?php $user = &JFactory::getUser();return $user->name;?> 

Email: 

<?php $user = &JFactory::getUser();return $user->email;?> 

Home Phone: 

<?php global $record; return $record->hphone; ?> 

Mobile Phone: 

<?php global $record; return $record->mobile; ?> 
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If you just want to populate the name and email then you can skip the Before Form Piece and just 
use the values for Name and Email. 

 

 Auto-Populate a Select List from Database Table 

Is it possible to automatically populate a select list from a database table? 

Yes, this is possible. 

You will need to write a 'Before Form Piece' - a small PHP script that gets executed before the form 
is loaded. Within it, you can specify a SQL statement, query the database and put the results into 
your form.  
 
The values of a select-list have the form 0;foo;bar so all you need to do is to dynamically build a 

string with the desired values and then provide it to the function mentioned below. Here is a sample 
Before Form Piece: 

$this->execPieceByName('ff_InitLib'); 

 

$test = "";  
for ($i = 0; $i < 10; $i++) { 

   $test .= "0;Product {$i};value{$i}\n"; 

} 

 

function ff_setSelectList($name, $value)  
{ 

  global $ff_processor; 

  for ($r = 0; $r < $ff_processor->rowcount; $r++) { 

    $row =& $ff_processor->rows[$r]; 

    if ($row->name==$name) 

      $row->data2 = $value; 

    unset($row); 

  } // for 

} // ff_setSelectList 

 

ff_setSelectList('select1', $test);  

To use it, Go to your form's properties and then to the 'Advanced' tab > More options. In the popup 
window that opens, select the tab 'Form pieces.' In the BEFORE FORM section, choose the 
'Custom' radio button. Paste your script in there and then make changes as needed. (You will 
probably want to replace the static 'for' loop with your SQL query.) 
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Send Me a Copy Checkbox 

I want to give my users the option to have a copy of an email sent to them, rather than just 
sending it automatically with the mailback. Can I do that? 

Yes, you sure can! Here's how: 

1. Make sure you set up a textfield element for your user to add their Email address to. In the NAME 
field - for purposes of this example - call it "email." 

2. Go to the Advanced tab of your new Email element and check the MAILBACK checkbox. 

3. Click on SAVE PROPERTIES to save the changes you made to the element itself.  

4. Just before your submit button and/or Captcha image, create a new checkbox element. 

a) For the LABEL field, enter something like "Send Copy to My Email." 

b) For the NAME field, enter something unique, such as "email_sendcopy." 

c) In the VALUE field, enter something like "Copy Sent." 

5. Go to the Advanced Tab of the checkbox element and check the "Only send to corresponding 
mailback field when checked" checkbox. 

6. In the field "Name of textfield that is marked as mailback," enter the NAME that you gave your 
Email element. (For our example, we called it "email.") 

7. Click on SAVE PROPERTIES to save the changes you made to the element itself. 

8. Click on the SAVE icon in the upper right-hand corner of the screen to save the actual form. 

9. Test it out -- it should be working! :-) 

 

White Screen on Install 

I just tried to install BreezingForms and when I clicked the Upload and Install button, I just 
got a white screen. What should I do? 

The problem for this and many other installations encountering this error is due to a time-out in PHP. 
This can be confirmed by timing the attempted installation time. Typically this is set to 60 seconds, 
and the script may take longer than this to install.  
 
To correct it, change the php.ini file to have  

max_execution_time = 120  
max_input_time = 120 
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(Thanks to Andy500 for the great tip!) 

 

Error: $jq is not defined 

My multi-page form won't advance to the next page. When I check the Firefox error console, I 
see this message: Error: $jq is not defined. What do I do? 

To fix this, you need to reinstall the script library. To do so, follow these steps: 
 
1. Go to Components > BreezingForms > Configuration 
 
2. Click on PACKAGE INSTALLER at the bottom of the screen. 
 
3. Look in the list for stdlib.english and put a check in the box to the left of it. 
 
4. Click on the UNINSTALL PACKAGES icon in the upper right-hand corner of the screen. 
 
5. An alert will appear asking if you're sure you really want to uninstall the package. It's okay... be 
brave! Do it! :-)  You'll now be back at the PACKAGE INSTALLER screen. 
 
6. Unzip the attached zip file, and save the included stdlib.english.xml file to somewhere on your 
hard drive. 
 
7. Now we want to reinstall that package. By default, the radio button for UPLOAD PACKAGE FILE 
FROM CLIENT & INSTALL should be selected.  
 
8. Browse to the directory on your hard drive where you stored that xml file and select it. Highlight 
the file and click OPEN, or double-click the file and it should then appear in the filename field. 
 
9. Now click on the INSTALL PACKAGE icon in the upper right-hand corner of the screen.  
 
10. You'll then be directed to a Package Installation Report. Click the CONTINUE icon at the bottom 
of the screen. 
 
11. Now that part is done, so go to the MANAGE FORMS section and re-open your form. 
 
12. Once open, click on the SAVE icon in the upper right-hand corner of the screen. 
 
Now test your form. It should advance properly through the pages. 

Click Here to Download 

 
 
 

Error: Too Much Recursion 

My multi-page form won't advance to the next page. When I check the Firefox error console, I 
see this message: Error: Too Much Recursion. What do I do? 

http://crosstec.de/index.php?pid=file&fileid=422
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To fix this, you need to reinstall the script library. To do so, follow these steps: 
 
1. Go to Components > BreezingForms > Configuration 
 
2. Click on PACKAGE INSTALLER at the bottom of the screen. 
 
3. Look in the list for stdlib.english and put a check in the box to the left of it. 
 
4. Click on the UNINSTALL PACKAGES icon in the upper right-hand corner of the screen. 
 
5. An alert will appear asking if you're sure you really want to uninstall the package. It's okay... be 
brave! Do it! :-)  You'll now be back at the PACKAGE INSTALLER screen. 
 
6. Unzip the attached zip file, and save the included stdlib.english.xml file to somewhere on your 
hard drive. 
 
7. Now we want to reinstall that package. By default, the radio button for UPLOAD PACKAGE FILE 
FROM CLIENT & INSTALL should be selected.  
 
8. Browse to the directory on your hard drive where you stored that xml file and select it. Highlight 
the file and click OPEN, or double-click the file and it should then appear in the filename field. 
 
9. Now click on the INSTALL PACKAGE icon in the upper right-hand corner of the screen.  
 
10. You'll then be directed to a Package Installation Report. Click the CONTINUE icon at the bottom 
of the screen. 
 
11. Now that part is done, so go to the MANAGE FORMS section and re-open your form. 
 
12. Once open, click on the SAVE icon in the upper right-hand corner of the screen. 
 
Now test your form. It should advance properly through the pages. 

Click Here to Download 

 
 
 

Total Sum / Calculations with Checkbox Fields: How-To 

I have amounts in checkbox fields and need to display the total sum of all the fields. How do I 
do that? 

1. Create a form using QuickMode 
 
2: Add your checkbox fields.  
 
3a. Give them whatever LABEL you want, but make sure the NAME is something easy. For this 
example the names are d11, d12, d13, d14, d16, d18 and d1o (that last one is a lowercase letter o 
for "open", not the number zero). 
 

http://crosstec.de/index.php?pid=file&fileid=422
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3b: Give them a VALUE that is a dollar value. My values for this example are 35.00, 35.00, 35.00, 
35.00, 45.00, 55.00, and 70.00. 
 
3c: For each checkbox, click on the ADVANCED tab, and create an ACTIONSCRIPT event using 
CUSTOM, and check the action CLICK. In the code framework box put in this: 

Code: 

 
function ff_d11_action(element,action) { 

ff_amountowing_action(element,action); 

} 

 

 
Make sure you change the title to match the NAME of this checkbox. So for box d12 it would look 
like this: 

Code: 

 
function ff_d12_action(element,action) { 

ff_amountowing_action(element,action); 

} 

 

 
and so on. 
Make sure you click SAVE PROPERTIES after each field is created! 
 
4a. Create a text field with the NAME "amountowing" and a VALUE of 0. 
 
4b. On the ADVANCED tab click on READ ONLY so that people can not alter the amount. 
Under the ACTIONSCRIPT set it to CUSTOM. You do not need to click on any of the checkboxes, 
as this script runs from the checkboxes on your form (the ones you created in step 2). 
 
4c. In the code framework add this: 

Code: 

 
function ff_amountowing_action(element,action) 

{ 

   ff_getElementByName('amountowing').value = 0; 

   if (ff_getElementByName('d11').checked) 

   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d11').value); 

   } 

   if (ff_getElementByName('d12').checked) 

   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d12').value); 

   } 

   if (ff_getElementByName('d13').checked) 
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   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d13').value); 

   } 

   if (ff_getElementByName('d14').checked) 

   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d14').value); 

   } 

   if (ff_getElementByName('d16').checked) 

   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d16').value); 

   } 

   if (ff_getElementByName('d18').checked) 

   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d18').value); 

   } 

   if (ff_getElementByName('d1o').checked) 

   { 

      ff_getElementByName('amountowing').value = Number(ff_getElementByName('

amountowing').value) + Number(ff_getElementByName('d1o').value); 

   } 

} 

 

 
Note that to see all of that code you may have to scroll across! But you can just copy it and paste it 
into your form's code framework.  
 
4d. Modify that code to replace the names with the ones you used in step 2. If you used my names 
(d11, d12, d13, d14, d16, d18 and d1o) then it will work as is. 
 
Now save the properties, save the form, and publish. As you click the checkboxes on and off the 
amount owing will be updated with the correct sums. 

  

(Thanks to DavidLGCrawford for this solution!) 

 

Injecting CSS Files into a Form 

Can I call an existing stylesheet for my form? Or a new one that I've created?  

Yes, you can. 

 To do so, echo the link rel inclusion as a BEFORE FORM piece. 

Form Properties > Advanced Tab > More Options Link > Form Pieces 
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Then in the BEFORE FORM section, click on the CUSTOM button and add the following code: 

JFactory::getDocument()->addStyleSheet( JURI::root() . 'PATH-TO-

CSS' ); 

 
 
Then click on the SAVE icon at the bottom of that screen, and then, once back at the form properties 
screen, click on the SAVE icon in the upper right-hand corner of the screen.  

 
 

Dropdown Lists 

How do I create a dropdown list? 

A dropdown list in BreezingForms is defined as a SELECT-LIST element. In QuickMode, add a 
Select-List element to your form. In the 'List' field, you will see: 

0;Title 1;value1 

0;Title 2;value2 

0;Title 3;value3 

The '0' tells BreezingForms not to select the field. (If you wanted it to be selected upon form load, 
then change it to '1') 
 
The 'Title' is the label that will show up in the dropdown box. 
 
The 'Value' is what will be stored in the database and/or sent in the Email message. 

Let's say you want to add 'Please Select' or 'Choose' at the top of the dropdown list. To do that, add 
an extra line before your actual values, like so: 

0;Please Select; 

0;Title 1;value1 

0;Title 2;value2 

0;Title 3;value3 

You will notice that there is no 'value' assigned in the top row. That is so that if you want to create a 
validation rule forcing a user to make a selection, your 'Please Select' row won't be counted as an 
actual selection. 

To validate, the rule you should choose is FF::ff_valuenotempty. 
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Adding Links to Labels 

I want to add a link to my checkbox label so my visitors can click the link to view our terms 
and conditions before checking the box. How do I do that? 

In BreezingForms Version 1.7.3 Build 740 and higher, you can use basic HTML in the LABEL field of 
QuickMode. So, just create a checkbox element, and then in the Label field, enter something like: 

I agree to <a href="http://mysite.com/terms.html" 

target="_blank">Terms and Conditions</a> 

Click on the SAVE PROPERTIES button to save the changes to the element, and then click on the 
SAVE icon in the upper right-hand corner of the screen to save the form itself. 

==========================================  

In Version 1.7.2 and lower, the label doesn't allow hyperlinks.  
 
What you could do instead is to create a section (with properties of: normal, all in a row) that houses 
two more nested sections (each with properties of: normal, wrap after each element). 

In the first section (which will essentially be the left-hand section), you can add the text with hyperlink 
by clicking on the EDIT link in the section properties. Then click SAVE at the bottom of the screen to 
save the text, and then click SAVE PROPERTIES to save the page element. 

In the second section (the right-hand section), you can add the checkbox element. In the Advanced 
tab, check the HIDE LABEL checkbox so that only the checkbox shows. Then click SAVE 
PROPERTIES to save the changes you made to the checkbox element. 

Don't forget to click on the SAVE icon in the upper right-hand corner of the screen to save the form 
itself! 

 

PDF Exports - Form Order 

When I export to PDF in the back end, the fields appear in alphabetical order. I need them to 
appear in the same order as the form itself. How do I do that? 

For technical reasons, it is not possible to have the fields appear in the same order as your  form. 
This is due to the fact that the same export function is used for ALL forms stored on your system. As 
a result, there is no other way to handle this than by having them ordered alphabectially. 
 
You might be able to find an Excel macro on the web that could help you with re-ordering the fields 
on demand. 
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Export Form as PDF to Admin Email 

Is there a way for me to export the form as a PDF document to send to the admin Email? 
Yes, you sure can do that. Go to the form's properties > Advanced tab > More Options. 
 
In the 'Attachment' dropdown at the bottom, select the PDF option. You can also choose to log the 
form values to the database or not, and the option of only sending non-empty values. 
 
Once you have made the changes you want there, click the SAVE icon in the lower right-hand 
corner of that screen to save those form properties. You will then be redirected back to the form 
properties screen. Click on the SAVE icon in the upper right-hand corner of the screen to save the 
form. 

 
 

US State Abbreviations - Select-List 

I need to put all the US states in my form in a select-list. Do you have a copy of them that I 
can use without having to retype them all? 

Yes, we do. Create your select-list element and then, in the LIST field, enter the following code: 

0;State; 

0;AK;AK 

0;AL;AL 

0;AR;AR 

0;AZ;AZ 

0;CA;CA 

0;CO;CO 

0;CT;CT 

0;DC;DC 

0;DE;DE 

0;FL;FL 

0;GA;GA 

0;HI;HI 

0;IA;IA 

0;ID;ID 

0;IL;IL 

0;IN;IN 

0;KS;KS 

0;KY;KY 

0;LA;LA 

0;MA;MA 

0;MD;MD 

0;ME;ME 

0;MI;MI 

0;MN;MN 

0;MO;MO 

0;MS;MS 

0;MT;MT 

0;NC;NC 

0;ND;ND 

0;NE;NE 

0;NH;NH 

0;NJ;NJ 

0;NM;NM 

0;NV;NV 

0;NY;NY 

0;OH;OH 

0;OK;OK 

0;OR;OR 

0;PA;PA 

0;RI;RI 

0;SC;SC 

0;SD;SD 

0;TN;TN 

0;TX;TX 

0;UT;UT 

0;VA;VA 

0;VT;VT 

0;WA;WA 

0;WI;WI 

0;WV;WV 

0;WY;WY 
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Capture URL the Form was Submitted From 

We want to track which of our pages generates form completion by our visitors. Is there a 
way to capture and record the URL that a form was submitted from? 

Yes, there is. 

First, create a hidden field in your form with the following properties: 

Type: hidden input 

Label: Referring URL (or whatever you want to call it) 

Name: page 

Click on SAVE PROPERTIES to save the element data, and then click on the SAVE icon in the 
upper right-hand corner of the screen to save the form with the new element.  

Then, within your form's properties, go to Advanced > More Options. Then click on the FORM 
PIECES tab at the top of the popup screen. 

In the first section (BEFORE FORM), click on the CUSTOM button. In the field that opens up 
underneath that, enter this code: 

  

$pageURL = 'http'; 

 if ($_SERVER["HTTPS"] == "on") {$pageURL .= "s";} 

 $pageURL .= "://"; 

 if ($_SERVER["SERVER_PORT"] != "80") { 

  $pageURL .= $_SERVER["SERVER_NAME"].":".$_SERVER["SERVER_PORT"

].$_SERVER["REQUEST_URI"]; 

 } else { 

  $pageURL .= $_SERVER["SERVER_NAME"].$_SERVER["REQUEST_URI"]; 

 } 

 

 

$this->execPieceByName('ff_InitLib'); 

ff_setValue('page', $pageURL); // 'page' is the name of the hidd

en field 

 Then click on the SAVE icon in the lower right-hand corner of the screen to save the piece that you 
just added. 

When back on the form properties page, click on the SAVE icon in the upper right-hand corner of the 
screen to save the form itself. 
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Calendar: How to Insert Today's Date 
How do I insert today's date in the calendar field? 
Place this code in the calendar element's VALUE field: 

Code: 

 
<?php return date("m/d/Y") ?> 

 

 
 
If you don't want it to be editable, check the READ ONLY checkbox on the Advanced tab. You could 
also use this code in a hidden field. 

[Thanks to Erich Haubrich for the contribution!] 

 

Remove Back Button from Multi-Page Forms 

I don't want my users to be able to go back to a previous page in the form. Is there a way to remove 
the BACK button? 
Yes, you can do that. 
 
First, in your form properties, change the settings below as noted: 
 
Include Submit Button: NO 
Paging Include: NO 
 
(If your last page is a thank you page, you can still check that box here, but leave Paging Include set 
to NO.) 
 
Then SAVE PROPERTIES to save the element. 
 
Now go to page 1 of your form. Create a new element, as noted below: 
 
Type: Submit button 
Label: Next Page 
Name: nextPage1 (or whatever you want to call it) 
Value: Next Page 
 
Then go to the element's ADVANCED tab, and in the ACTIONSCRIPT section, do the following: 
 
Type: Library 
Actions: Click (checkmark) 
Script: FF::ff_validate_nextpage 
 
Then SAVE PROPERTIES to save the element. 
 
Do that for each page EXCEPT the one on which the submit button will be placed, as well as your 
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Thank You page, if you have specified one. 
 
On the page that will contain your submit button, create a new element with settings as follows: 
 
Type: Submit button 
Label: Submit 
Name: submit (or whatever you want to call it) 
Value: Submit 
 
Then go to the element's ADVANCED tab, and in the ACTIONSCRIPT section, do the following: 
 
Type: Library 
Actions: Click (checkmark) 
Script: FF::ff_validate_submit 
 
Then SAVE PROPERTIES to save the element. 
 
Once are of your buttons have been created, click on the SAVE icon in the upper right-hand corner 
of the screen to save the form itself. 
 
You will likely have to make some CSS adjustments to your SUBMIT button settings to get the 
placement of it the way you want it, but this will at least get the function there for you. :-) 

 

Collect Page Title in Form Details  

I have my form set up in a module position. I want to collect the title of the page that they are 
on when they submit the form. 

To capture the page location, create a new element of type HIDDEN INPUT. For this example, let's 
name that element PageTitle. The value field in the element should be empty. 

Click on SAVE PROPERTIES to save the new element, and then click on the SAVE icon in the 
upper right-hand corner of the screen to save itself. 

Now go to your form's properties > Advanced tab > More Options and click on the SCRIPTS tab. In 
the INITIALIZATION SCRIPT section, click on the CUSTOM button. Then click on the "Create code 
framework" text. A message will popup saying: 

Create code framework for init now? 
(Existing code will be appended) 

Click OK. 

A textarea will appear with code in it that looks similar to the following: 

function ff_YourFormName_init() 

{ 

} // ff_YourFormName_init 
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On the line right below the first curly bracket -- { -- add the following code: 

ff_getElementByName('PageTitle').value = 

window.parent.document.title;  

 
So the final code should look something like this: 

function ff_YourFormName_init() 

{ 

   ff_getElementByName('PageTitle').value = 

window.parent.document.title;  

} // ff_YourFormName_init 

 
Note: If your hidden element is named something other than PageTitle, then you will need to change 
that in the code above. 

Click on the SAVE button at the bottom of the screen to save the script changes, and then click on 
the SAVE icon in the upper right-hand corner of the screen to save the form itself.  

 

Change Default Email Subject 

Is there a way to change the subject in the email address? Right now it just says "Form 
record received."  
Go to your form's properties > Advanced tab > More Options. On that screen, near the bottom, you 
should see a field where you can enter a custom Email subject. Add it there, then click the SAVE 
button at the bottom of that screen. When you are taken back to the properties screen, click on 
SAVE PROPERTIES, and finally, to save the form itself, click on the SAVE icon in the upper right-
hand corner of the screen. 
 
That should do it. :-) 
 
 
 

Reduce Spacing Between Label and Field  

How do I change the amount of space there is between the form label and the field? 

Go to your theme.css file. In Build 730 and higher, it should be located in: 

/components/com_breezingforms/themes/quickmode/*THEME_NAME*/theme.css 
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In Build 729 and lower, it should be located in: 

/components/com_facileforms/themes/quickmode/*THEME_NAME*/theme.css 
  

Look for: 

.bfQuickMode .bfInline .bfLabelLeft .bfElementGroupNoWrap 

input[type='text'] { 

  width: 48%; 

} 

 
You can change that percentage to whatever you want. (I changed the width in my forms to 22% 
which seemed to layout fairly nicely. Your mileage may vary...) 

 

Translating Forms to Other Languages 

It looks like only Classic Mode supports Joomfish. How can I translate my QuickMode and 
EasyMode forms to different languages? 

1. Create a master form in English. 

2. Make one copy of the master form for each language that you need, and give each copy a unique 
name. (For example, "myFormFR" or "myFormSP") 

3. Translate all items for each form. 

4. Publish the master form as a regular BreezingForms menu item. 

5. Translate the published menu item using Joomfish, and in the formname field use the unique 
name as described above (e.g. "myFormFR" or "myFormSP") 
 
You will see that this is a lot faster and less stressful than using Joomfish. 

How Do I Create a Hidden Menu? 

I need to publish an article on my site, but I don't want to show it in the menu. Is there a way 
to do that? 

Yes, there is. 

Go to Menus > Menu Manager and then click on the NEW icon in the upper right-hand corner of the 
screen. 

In the screen that opens, enter the following information: 
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Unique Name: hidden (or invisible, or whatever you want to call it - this should be a single word with 
no spaces or other special characters) 

Title: Hidden Menu (or Invisible Menu, or whatever you want to call it) 

Description: Enter a descriptive phrase 

Module Title: Leave blank. 

When you are returned to the Menu Manager screen, make note of the ID that is assigned to your 
hidden menu. (The ID should be the farthest column on the right.) 

Now, when you hover over the MENUS tab at the top of the Joomla screen, you should see your 
hidden menu listed there. Click on it, and then click on the NEW icon in the upper right-hand corner 
of the screen. 

In the dialogue box that opens, select Menu Type: Articles > Article Layout. 

In the parameters on the right-hand side, select the article that you want placed in the hidden menu. 
Make sure that the Display In field shows your hidden menu. Fill in the other fields as you normally 
would, and then click on the SAVE icon in the upper right-hand corner of the screen.  

When you are returned to the Menu Item Manager screen, make note of the ItemID that is assigned 
to your new menu item. 

To create a link to the article, use the following format: 

http://yourdomain.com/index.php?option=com_content&view=article&id=xx&Itemid=yy  

Replace xx with the ID number of the article you want to link, and replace yy with the ID number 
assigned to your hidden menu. 

Now test the URL to make sure that it works. 

  

LINKING A FORM TO A HIDDEN MENU  

If you want to link a BreezingForms form directly to a hidden menu, then create the hidden menu as 
noted above. Find the hidden menu in the Menus dropdown. Click on it, and then click on the NEW 
icon in the upper right-hand corner of the screen. 

In the dialogue box that opens, select Menu Type: BreezingForms. In the parameters section, enter 
the form name EXACTLY AS SHOWN (including case sensitivity) in the NAME column on the 
Manage Forms screen. Make sure that the Display In field shows your hidden menu. Fill in the other 
fields as you normally would, and then click on the SAVE icon in the upper right-hand corner of the 
screen.  
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When you are returned to the Menu Item Manager screen, make note of the ItemID that is assigned 
to your new menu item. (It will be in the last column of the form.) 

To create a link to your form, use the following format: 

http://yourdomain.com/index.php?option=com_breezingforms&Itemid=xx  

Replace xx with the ItemID number of the form you want to link to, as noted above.  

Now test the URL to make sure that it works. 

  

NOTE: If you are using BreezingForms version 729 or earlier, the URL should be linked as: 

http://yourdomain.com/index.php?option=com_facileforms&Itemid=xx  

 

Restrict Form Submission for Entry Form 

I have a contest running on my website, but users are only allowed to enter once. Is there a 
way to restrict them so they can't? 
Yes, there is. 
  
Please see the attached PDF file for complete details. 

Click Here to Down 

 

 

Form Text Won't Save 

I am trying to save text in a page but no matter what I do, it won't save! Why not? This 
happens with sections, too.  
Are you using JCE as your text editor? If so, there is currently a known bug that we are trying to 
resolve, but switching to TinyMCE has worked for the users that have reported the issue to us. 
 
When creating text, there are three things that you need to do in order to save it: 
 
1. Click on the SAVE icon at the bottom of the text entry / WYSIWIG screen. 
 
2. Click on the SAVE PROPERTIES button to save the form element. 
 
3. Click on the SAVE icon in the upper right-hand corner of the screen to save the text itself. 

http://crosstec.de/support/index.php?pid=file&fileid=822
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Is There a Way to Add Text to My Form? 

Is there a way to add text to my form? I don't want to put it in an element, but I need it placed 
beside or underneath it. 

Yes, you can add 'free text' in BreezingForms within a page or a section. 

At the page level, your text would appear above the form. To do so, click on the Page title in the left-
hand 'tree,' and then click on the EDIT link to the right of the word INTRO in the right-hand 
properties. Within the editor that opens, you can add HTML, images, etc. 

To place text elsewhere in the form, create a new section where you want the text to be placed, and 
then click on the EDIT link that will appear in the right-hand element properties. Within the editor that 
opens, you can add HTML, images, etc. 

 

Form Jumps to ReCaptcha 

As soon as I open the webpage with my form on it, it jumps straight to the ReCaptcha field. 
How can I make the focus stay at the top of the page? 

In Build 730 and higher, go to /com_breezingforms/libraries/crosstec/classes and 
open the file BFQuickMode.php. 

In that file, look for this code: 

Code: 

 
 

"bfReCaptchaDiv", { 

theme: "'.addslashes($mdata['theme']).'", 

callback: Recaptcha.focus_response_field 

} 

 

 
 
and replace it with: 

Code: 

 
 

"bfReCaptchaDiv", { 

theme: "'.addslashes($mdata['theme']).'" 

} 
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Now in Build 730 and higher, go 
to /administrator/components/com_breezingforms/libraries/crosstec/classes. (In Build 729 and 
lower, go to /administrator/components/com_facileforms/libraries/crosstec/classes) and do the 
same thing: 

Open the file BFQuickMode.php and in that file, look for this code: 

Code: 

 
 

"bfReCaptchaDiv", { 

theme: "'.addslashes($mdata['theme']).'", 

callback: Recaptcha.focus_response_field 

} 

 

 
 
and replace it with: 

Code: 

 
 

"bfReCaptchaDiv", { 

theme: "'.addslashes($mdata['theme']).'" 

} 

 

  

Focus should now be returned to the top of the page. 



[User Guide]  [Crosstec/Breezing Forms] 

Page 126 

Put Cursor in First Field 

How do I get the cursor to be in the first field of my form when someone goes to that page? 

In techno-speak, this is called getting focus. 

If your form contains only one page (or one page and a thank you page), do the following: 

1. Go to the Advanced tab of the first element on your form. 

2. Scroll down to the Initscript section and add the following settings: 

Type: Custom 

Form Entry or Page Entry - Put a checkmark beside FORM ENTRY 

Script: FF::ff_getfocus 

3. Then click on SAVE PROPERTIES to save the changes you just made to the form element. 

4. Now click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 

If your form contains multiple pages, then follow steps 1-4 above for the first page. 
On subsequent pages, do the following: 

5. Go to the Advanced tab of the first element on the second (third, fourth, etc.) page of your form. 

6. Scroll down to the Initscript section and add the following settings: 

Type: Custom 

Form Entry or Page Entry - Put a checkmark beside PAGE ENTRY 

Script: FF::ff_getfocus 

7. Then click on SAVE PROPERTIES to save the changes you just made to the form element. 

8. Now click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 

  

Make sure that you only use the focus script in ONE element on a single page.  
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Send Field Values to a Different URL 

I want to send my form values to a URL instead of sending them in an email message. Can I 
do that? 
Yes, you can. Just re-submit the values using a hidden form, right after the submit. To do this, go to 
your form's properties > Advanced Tab > More Options. Then click on the SUBMIT PIECES tab and 
scroll down to the END SUBMIT section. 
 
Click on the CUSTOM radio button, and in the textarea that opens, add the following code: 

Code: 

 
 

$this->execPieceByName('ff_InitLib'); 

 

echo ' 

<form name="myresubmit" action="YOUR-TARGET-URL"> 

   <input type="hidden" name="somefield" value="'.htmlentities( ff_getSubmit(

'somefield') ).'"/> 

   <input type="hidden" name="somefield2" value="'.htmlentities( ff_getSubmit

('somefield2') ).'"/> 

   <input type="hidden" name="somefield3" value="'.htmlentities( ff_getSubmit

('somefield3') ).'"/> 

   <!-- and so on ... --> 

</form> 

<script> 

document.myresubmit.submit(); 

</script> 

'; 

 

exit; 

(Remember to replace the 'somefield' variables with your field 

names!) 

 

Center Submit Button 

Is there a way to center the submit button? 

To center the submit button, add the following code to your template.css file or theme.css file. In 
Build 730 and higher, you will find them at: 

/joomlaRoot/templates/*TEMPLATE-NAME*/template.css 

 

/components/com_breezingforms/themes/quickmode/*THEME-NAME*/theme.css 
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Add this code: 

.bfQuickMode .bfSubmitButton { 

float: none; 

margin-left: 45%; 

} 

 

Gap in Form Headings 

I am trying to create my first form, but I am having trouble with it displaying properly. When I 
add a field set, there is a break in the graphic. What can I do to fix it? 

Look in your CSS files for a stylesheet called “reset.css.” Line 59 of reset.css has this code: 

form div { 

margin:10px 0; 

} 

 
It is that margin that is causing the gap between your heading and the form itself. Try setting it back 
to 0 and that should fix it. 

For more information, please see this forum post. 

 

Adjust Label and Input Position 

How do I adjust the position of the label vs. the input field in QuickMode? It appears that the 
standard configuration splits the columns 50/50. Is there a simple way to adjust this ratio 
throughout? 

Yes, there is. Just add this code to your template.css* file: 

  

Code: 

 
 

.bfQuickMode p input[type='text'], .bfQuickMode p textarea, .bfQuickMode p se

http://www.crosstec.de/forums/3-breezingforms-general-forum-english/12611-solved-field-sets-are-not-showing-up-properly.html
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lect { 

width: 55%; 

} 

.bfQuickMode .bfLabelLeft label { 

width: 35%; 

} 

 

 
You can adjust the width percentages there to whatever you prefer. 

  

* It is recommended that you add this code to your template.css file instead of the BreezingForms 
system.css file because you would lose the changes the next time you upgrade the extension. 

 

Custom CSS for Sections and Elements 

I have a checkbox group with a number of options. I can't get the values to display across the 
entire form. They break into two lines. Is there a way to fix that? 

First, copy one of the theme folders (e.g. /QMtheme/) and rename the folder to 'MyTheme' or 
whatever name you want to give it.  

Next, take a look at the HTML source code for your form. Every form element is assigned a unique 
ID selector, which can be used to add custom styling to the form. 

For your checkbox group element, locate the unique ID selector, and then define it in your new 
theme.css file, as follows: 

Code: 

#ID-OF-DIV { 

  width:100% 

} 
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Printing a Form 

We want our users to be able to print out their form. Is there a way to do that? 

Yes, there is. 

First, on the form properties screen, make sure that the INCLUDE SUBMIT BUTTON option is set to 
NO, and then click on SAVE PROPERTIES. 

Now you need to create a summary page for your form. If you don't know how to do that, please see 
the section How To Create a Form Summary 

Once you have added all of your summarize elements, create a new element with the following 
properties: 

Type: Submit Button 

Label: Print 

Name: PrintButton 

Value: Print Page 

Click on the SAVE PROPERTIES button, and then go to the Advanced tab. Scroll down to the 
ACTIONSCRIPT section of the page, and add the following settings: 

Type: Custom 

Actions: Click (should be CHECKED) 

Click on the words CREATE CODE FRAMEWORK. An alert will appear that says: 

Create code framework for action now? 
(Existing code will be appended) 

Click on OK. 

Look for this line: 

        case 'click': 

Add a new line UNDERNEATH that line, as follows:  

        window.print(); 

So the code framework should look like this: 
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function ff_PrintButton_action(element, action) 

{ 

    switch (action) { 

        case 'click': 

        window.print(); 

            break; 

        default:; 

    } // switch 

} // ff_PrintButton_action 

 

  

Click on SAVE PROPERTIES to save the element, and then click on the SAVE icon in the upper 
right-hand corner of the screen to save the form itself. 

  
Now you need to add a SUBMIT button to the form. To do so, create a new element with the 
following properties: 

Type: Submit Button 

Label: Submit 

Name: submitButton 

Value: Submit 

Click on the SAVE PROPERTIES button, and then go to the Advanced tab. Scroll down to the 
ACTIONSCRIPT section of the page, and add the following settings: 

Type: Library 

Actions: Click (should be CHECKED) 

Script: FF::ff_validate_submit  

Click on SAVE PROPERTIES to save the element, and then click on the SAVE icon in the upper 
right-hand corner of the screen to save the form itself.  

You should now see two buttons on your form: one to print, and one to submit. Go ahead, give it a 
try and test your form! If you've done everything right, a print window should appear when you click 
on the print button, and once you say OK to print, a print dialog box should appear. 
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Summarize Elements Are Empty 

I created summarize elements using the instructions I found in the KnowledgeBase, but when 
I test my page, the summaries are all empty. How can I fix this? 

For reasons we have not yet been able to determine, the summarize fields occasionally just do not 
'take,' even if they have been coded correctly. 
 
One workaround we have found is to try copying the elements that contains your summarize 
elements, and then paste them back in again. 

To do so, highlight the element name in the left-hand directory 'tree,' then right-click on it and click 
on COPY. Next, highlight the Page line in the directory tree that contains your summarize elements, 
right-click on it and then click on PASTE. 
 
Once you have done that for each element, you need to delete the original elements that you 
created. (They should be the ones at the top of the page. Your copied elements will show up below 
them.) 

Now open up each of the summarize elements and make sure they are correctly mapped to your 
original elements. Click on SAVE PROPERTIES for any summarize element that you have to 
change, and then click on the SAVE icon in the upper right-hand corner of the screen to save the 
form itself. 

  

Section Short-Cut 

If your summarize elements are contained within a section, this becomes much easier. You can then 
highlight the SECTION name in the left-hand directory 'tree,' right-click on it and click on COPY. 
Next, highlight the Page line in the directory tree that contains your summarize elements, right-click 
on it and then click on PASTE. 

Now open up each of the summarize elements and make sure they are correctly mapped to your 
original elements. Click on SAVE PROPERTIES for any summarize element that you have to 
change, and then click on the SAVE icon in the upper right-hand corner of the screen to save the 
form itself. 

 

Forcing a Phrase Match 

I want to add a coupon code to my form. The code will be the same for everyone, but I don't 
know how to make sure they enter the right code. Can I even do that? 

Sure you can! :-) 

1. Go to your form, and then to the text element that you are using for your Coupon Code field. For 
the purposes of this example, we're going to call the element "CouponCode" (without quotes) in the 
NAME field underneath the "Label" field. 
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2. Put a checkmark in the Validation box, and then click on the radio button to the right of the word 
'Custom' in the next line. 
 
3. Enter an error message (for example: "Please enter a valid coupon code"). 
 
4. Click on "Create code framework." (It doesn't look like a link, but it is!) A javascript popup will 
appear which says: 

Create code framework for validation now? 
(Existing code will be appended). 

Click on OK. 

5. In the text area that opens, delete all of the code which is currently there, and replace it with: 

function ff_CouponCode_validation(element, message) 

 { 

  if (element.value == "ABC123"){ 

   return ''; 

  } 

  return 'Please enter a valid coupon code'; 

 } // ff_CouponCode_validation 

 
6. IMPORTANT: If you name your element something other than CouponCode, you will need to 
change that text in the top and bottom line of the code above to match the name you gave the 
element.   

7. In this line: 

  if (element.value == "ABC123"){ 

replace ABC123 with your actual coupon code. 

For example, if your coupon code is XG1974BG, then that line should say: 

  if (element.value == "XG1974BG"){ 

 
8. Now click on SAVE PROPERTIES to save the validation rule to the element. 

9. Click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 

10. Test your form. It should work. :-) 
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Add Section Header in Email 

When I divide my form into sections, the section title doesn't appear in the Email. Is there a 
way to make it show? 

BreezingForms currently doesn't offer this feature, but one of our users suggested the following 
workaround. (Thanks, SoftDux!) 

Add a hidden Input element with the section's name where you want it to appear, i.e. just above or 
below the section name, with settings as follows: 
 
Type: Hidden Input 

Label: 1  
 
(The label can't be hidden in this element, so numbering each section sequentially seems to look 
best for display purposes.) 
 
Name: Personal_Info_Header (or whatever you want to call it) 

Value: PERSONAL INFORMATION (or whatever your section title is called) 

You might want to make the header a bit more prominent by changing the value to something like 
this: 

----- PERSONAL INFORMATION ----- 

 

or 

 

_____PERSONAL INFORMATION_____ 

 

or 

 

***** PERSONAL INFORMATION ***** 

 

etc. 
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Create a Popup Thank You Message 

Instead of going to a thank you page, I just want a popup that tells the user their form has 
been received. Is there a way to do that? 
To create a popup alert, go to your form's properties > Advanced tab > More Options, and then click 
on the SCRIPTS tab.  
 
In the SUBMITTED SCRIPT section, click on type: Custom. 
 
A textarea should appear. Click on the words GENERATE CODE FRAMEWORK that appear. Inside 
the textarea, add the following code: 
 

alert("Thank you for your inquiry."); 

 
(You can change the message inside the quotation marks to whatever you want. 

 

Turn a Section Off for Registered Users 

If a registered user is filling in a form i don't want to collect information about him that we 
already know, such as name, surname, address, etc. But if a new user fills out the form, then I 
want that information collected. Is there a way to do that? 

This example assumes that you have two sections to your form. The first section (tagged as Section 
1 in the image below) would be presented to users who are not logged in, but would be hidden for 
users who ARE logged in. Section 2 would be displayed to all users, logged in or not. 
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For the purpose of this example, in the NAME field (underneath the label field in each section's 
properties), let's name the sections as follows: 
 
Section 1 name: section1 

Section 2 name: section2 

 
All of the following code assumes that you are using these two section names!! 
 
Go to your form's properties > Advanced Tab > More Options and click on the SCRIPTS tab. 
 
In the Initialization Script section, click on the CUSTOM radio button. Now click on the words 
CREATE CODE FRAMEWORK. An alert will pop up that says: 

Create code framework for init now? 
(Existing code will be appended) 

 
Click on OK. 
 
In the textarea that opens, you should see code that looks something like this: 

function ff_FORMNAME_init() 

{ 

} // ff_FORMNAME_init 

After the first curly bracket in the second line of code, click ENTER to go to a new line. Then paste in 
the code below: 

<?php 

if(  JFactory::getUser()->get('id',0) > 0 ) 

{ 

   echo 

" 

function mytoggler() 

{ 

    bfToggleFields('off', 'section', 'section1', 

bfDeactivateField); 

    bfToggleFields('on', 'section', 'section2', 

bfDeactivateField); 

} 

"; 

} 

else 

{ 

   echo 

" 
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function mytoggler() 

{ 

    bfToggleFields('on', 'section', 'section1', 

bfDeactivateField); 

    bfToggleFields('on', 'section', 'section2', 

bfDeactivateField); 

} 

"; 

} 

?> 

 

--------------------------------------------------------------------------------------------------- 

  

The code, once complete, should look something like this: 

 
 
function ff_FORMNAME_init() 

{ 

<?php 

if(  JFactory::getUser()->get('id',0) > 0 ) 

{ 

   echo 

" 

function mytoggler() 

{ 

    bfToggleFields('off', 'section', 'section1', 

bfDeactivateField); 

    bfToggleFields('on', 'section', 'section2', 

bfDeactivateField); 

} 

"; 

} 

else 

{ 

   echo 

" 

function mytoggler() 

{ 

    bfToggleFields('on', 'section', 'section1', 

bfDeactivateField); 

    bfToggleFields('on', 'section', 'section2', 
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bfDeactivateField); 

} 

"; 

} 

?> 

} // ff_FORMNAME_init 

 

--------------------------------------------------------------------------------------------------- 

Next, go to the FORM PIECES tab. In the AFTER FORM section, click on the CUSTOM radio 
button. In the text area that opens, enter the following code: 

return ' 

<script> 

JQuery(document).ready(function() { 

   mytoggler(); 

}); 

</script> 

'; 

Now click on the SAVE icon in the lower right-hand corner of the screen to save the script and form 
piece changes that you made. Once back on the form properties page, click on the SAVE icon in the 
upper right-hand corner of the screen to save the form itself. 

 

 

Calculating Textfields 

I need to have my users put numbers in a text field and then show a total amount. Can I do that? 

Yes, you can. 

Please see the attached PDF document for instructions on how to do so. It will work for textfields, 
select-lists, or a combination of the two. 

Click Here to Download 

  

Put Form in Lightbox Popup 

I would like to present a BreezingForms form in a popup using LightBox. Can I do that? 

http://crosstec.de/support/index.php?pid=file&fileid=4431
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Yes, you can. 
 
Add the code below into the index.php of your template -- let's say as the very first line: 

<?php JHTML::_( 'behavior.modal' ); ?> 

 

Then you can add a link to any of your pages like this: 

<a 

href="index.php?option=com_breezingforms&amp;ff_name=FORMNAME" 

title="My Form" class="modal" rel="{handler: 'iframe', size: {x: 

570, y: 200}}">My Form</a> 

Replace FORMNAME with the name of your form and use the x and y values to define the size for the 

modal window. 

(If it does not work using that code, try changing index.php to index2.php.) 

 

Disappearing Form Elements 

My form isn't showing checkboxes, select-lists or other form elements. Help! What am I doing 
wrong? 

Are you using a Rocket Themes template, by any chance? If so, some of them have a feature in the 
advanced settings to turn INPUT STYLING on or off. If it is on, try turning it off and then check your 
form again. It is often the culprit with this issue! 

 

Conditional Rules and Fieldset Borders 

I set up some conditional sections that are hidden unless a certain option on my form is selected. 
However, the borders of the hidden areas show up for some reason. How I can hide the hidden 
sections when the section isn't active? 

You can get around this by enclosing your FIELDSET section within a NORMAL section. To do that, 
create a new section. (For demonstration purposes, let's call this Section1.) Leave the Title blank 
(delete any text displayed by default). Now go to the Advanced tab and place a checkmark in the 
TURN OFF checkbox. Click the SAVE button to save your new element. 
 
Next, in the directory 'tree' on the left-hand side, drag the original FIELDSET section into the new 
NORMAL section you just created. (Let's call this section Section1Fieldset.) Go to the advanced tab 
and uncheck the TURN OFF checkbox. Click the SAVE button to save your changes. 
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Do this for each of the fieldset sections that you need to hide. 
 
Now you need to go to the form's Advanced tab to change your conditional statements, like so: 

turn on section Section1Fieldset if OriginalElement1 is yes 

turn off section Section1Fieldset if OriginalElement1 is no 

That should do it! 

 

 

Visibility Rules: Remove Border Around Hidden Sections 

When a visibility rule is hidden, there is still a border around the empty fieldset. How can I make it so 
that doesn't show? 

You can get around this by enclosing your FIELDSET section within a NORMAL section. To do that, 
create a new section. (For demonstration purposes, let's call this Section1.) Leave the Title blank 
(delete any text displayed by default). Now go to the Advanced tab and place a checkmark in the 
TURN OFF checkbox. Click the SAVE button to save your new element. 
 
Next, in the directory 'tree' on the left-hand side, drag the original FIELDSET section into the new 
NORMAL section you just created. (Let's call this section Section1Fieldset.) Go to the advanced tab 
and uncheck the TURN OFF checkbox. Click the SAVE button to save your changes. 
 
Do this for each of the fieldset sections that you need to hide. 
 
Now you need to go to the form's Advanced tab to change your conditional statements, like so: 

turn on section Section1Fieldset if OriginalElement1 is yes 

turn off section Section1Fieldset if OriginalElement1 is no 

 
That should do it! 

 

Calendar: validating date in the past (MM-DD-YYYY Format) 

How do I command the calendar function to have a warning message when a user chooses a date in 
the past? 
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That requires a custom validation for the calendar item (calendar item => validation => click "custom" 
=> click "generate code framework"), Inside the generated function you put this (between { and }) 
such that it looks like this: 

function ff_CALENDARITEMNAME_validation(element, message) 

{ 

  if(element.value.split("-").length != 3){return message == '' 

? element.name+" faild in my test.n" : message} 

 

var vDate = new Date(Number(element.value.split("-")[1])-1, 

element.value.split("-")[2], element.value.split("-

")[0],0,0,0,0).getTime(); 

 

  var today = new Date(); 

  today.setHours(0); 

  today.setMinutes(0); 

  today.setSeconds(0); 

  today.setMilliseconds(0); 

  today = today.getTime(); 

 

  if(vDate < today) 

  { 

   if (message=='') message = element.name+" faild in my 

test.n"; 

   return message;  

  } 

  return ''; 

}  

 
This example is for the js calendar default date pattern (MM-DD-YYYY), therefore the javascript 
above might be slightly different for other patterns, for instance german. 
 
Also note: CALENDARITEMNAME has to be replaced by your calendar item's name. This is 
automatically done by clicking "Generate Code Framework".  

 

Visibility Rules Don't Display in IE 

I have a form with conditional (visibility) rules, and it works fine in FireFox and Chrome, but 
the rules don't work in Internet Explorer 7 or 8. Please help! 

In some cases, the problem originates with template code. For example, a number of templates from 
RocketThemes have an advanced option to customize the look of form elements. Try disabling that 
feature (in the Template Manager section) and see if that corrects the issue. 
 
(Thanks to user gtmaniak for the suggestion!) 
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Another possibile solution: Turn on JS Compatibility (a feature built into the Rockettheme template), 
which could solve the issue. 

(Thanks to user jimbo717 for this suggestion!) 

 

Limit the Number of Submissions 

  

Is there a way to limit the number of forms that can be submitted? This would come in handy 
if I needed to limit the number of entries for a contest, or registration for an event, etc. 

  

Yes, you can do this by creating a BEFORE FORM PIECE. 

To do that, go to your form's properties > Advanced Tab > More Options, then click on 
the PIECES tab. In the BEFORE FORM section, click on the "Custom" radio button and add the 
code below.  
 
IMPORTANT: You will need to change the "999" in the code below to the ID of your form. To find the 
ID number, go to Components > BreezingForms > Manage Forms. You will find the ID number for 
your form in the Script ID column. 

To set a limit on the number of submissions, change the "100" in the load result line to whatever 
number of submissions you want to allow.  
 
You will also need to replace the URL in the Header Location to the URL for your Limit 
Exceeded notice page. 
 
  

Code: 

 
 

$db = JFactory::getDBO(); 

$db-

>setQuery("Select count(id) From #__facileforms_records Where form = 999"); 

if( $db->loadResult() > 100 ){ 

  // replace index.php with the url to an article explaining that the max. am

ount has been reached 

  header("Location: index.php"); 

  exit; 

}  
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Select-List Generates Database Error 

I am trying to create a form with a drop-down list, but when I test it, it generates this error 
message: "500 - No validdatabaseconnection."  If I turn off the select-list, the error goes 
away. Is there a fix for this? 

We have had some reports of this happening on Joomla installations that use Joomfish. Please try 
changing your database from mysql to mysqli in Joomla's Global Configuration settings and see if 
that fixes it. 

 

Remove Field Label From Tooltips 

  

The tooltips for my form show the field label before the tip. Is there a way to remove it? 

  

Usability rules typically say to repeat the label of a field in the tooltip, so that is how BreezingForms 
has been set up. You can remove it with a hack though. To do so, open: 
 
/administrator/components/com_breezingforms/libraries/crosstec/classes/BFQuickMode.php 
 
Around line 902-903, look for this line: 

$tipScript   = '<script type="text/javascript"><!--

'."\n".'JQuery("#bfLabel'.$mdata['dbId'].'").qtip({ position: { 

adjust: { screen: true } }, content: 

"<b>'.addslashes(trim($mdata['label'])).'</b><br/>'.str_replace( 

array("\n","\r"), array("\\n",""), addslashes($content) 

).'"'.$style.' });'."\n".'//--></script>'; 

and change it to: 

$tipScript   = '<script type="text/javascript"><!--

'."\n".'JQuery("#bfLabel'.$mdata['dbId'].'").qtip({ position: { 

adjust: { screen: true } }, content: "'.str_replace( 

array("\n","\r"), array("\\n",""), addslashes($content) 

).'"'.$style.' });'."\n".'//--></script>'; 

 
That should do it. 
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Abuse Warning Error 

I am trying to export a package of a form I created so I can move it to a new site. When I click 
on the continue button for Create Package I get: 
 
*** ABUSE WARNING *** 
 
Your attempt to hack BreezingForms has been registrated. 

What's wrong?  

  

Check to see whether the folder /PACKAGES/ in /administrator/components/com_breezingforms/ is 
writable. If it is not, that could be one reason why you are getting this message. (You could also try 
enabling the Joomla! FTP layer to see if that removes the error.) 
 
Another possibility is that there could be an ownership error. (The /packages folder should be owned 
by the webroot.) If you change the permissions on the folder to 777 and the error message 
disappears when creating a package, then that can be a clue that ownership is the issue. 

 

Use Select-List to 'Jump' to Different URL 

I want to make a dropdown box where if they choose one option, it will go to one URL, option 
#2 would redirect them to a different URL, option #3 to yet another URL, and so on. Is that 
possible? 

Yes, it is. 

First, create a select-list element. For the purpose of this example, we will name the 
element Choose. 

In the 'List' field of the element, put: 

0;Choose Page; 

0;Choice1 Title;Page 1 

0;Choice2 Title;Page 2 

0;Choice3 Title;Page 3 

(Replace 'Choice1 Title' / 'Choice2 Title' / 'Choice3 Title' with whatever text you want to show  in the 
dropdown list.) 

Now go to the Advanced tab of your select-list element. In the Actionscript section, make these 
changes: 
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Type: Custom 

Actions: Change (the third checkbox from the left) 

In the Create Code Framework textbox, enter the following code: 

 
function ff_Choose_action(element, action) 

{ 

switch (action) { 

case 'change': 

if( element.value == 'Page 1' ){ 

   location.href="http://YourFirstLink.com"; 

}else if( element.value == 'Page 2' ){ 

   location.href="http://YourSecondLink.com"; 

}else if( element.value == 'Page 3' ){ 

   location.href="http://YourThirdLink.com"; 

} 

break; 

default:; 

} // switch 

} // ff_Choose_action 

 

 Remember to replace the location.href URLs with your actual page links.  

NOTE: If you name your element something other than "Choose," then you will need to change the 
first and last line of the code to match your element name, by replacing the ELEMENTNAME text to 
the actual name of your element: 

function ff_ELEMENTNAME_action(element, action) 

and at the end of the code: 

} // ff_ELEMENTNAME_action  

Now click on the SAVE PROPERTIES button at the bottom of the screen to save the element you 
just created, and then click on the SAVE icon in the upper right-hand corner of the screen to save 
the form itself. 

Test it out -- you should now have a dropdown list that will 'jump' to whatever page you want. :-) 

This same principle can be applied to sections, too. As long as you identify the unique ID number 
assigned to the section or element, you can define a style for it. 
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How to Add Google Analytics Code 

Is there a way to add Google Analytics tracking code to my form? 

The easiest way to do this is to create a separate Joomla article as your thank you page and add 
your Analytics code there. 

Then, in your form, you will want to redirect to that thank you page after submit. Take a look at URL 
for Thank You Page 

 

 Hidden Sections and Validation Rules 

I have a form that has several sections that are not visible unless a certain radio button is 
checked. When I submit the form, the validation scripts for the elements within the hidden 
section are still triggered. How can I prevent these validation scripts from operating if the 
section is hidden? 

 

Check to see if you have one or more sections or fieldsets nested inside each other. If so, then the 
validations won't turn off due to performance reasons. 
 
Please rearrange the sections (or fieldsets), so the section holding the fields won't be nested in a 
parent section. Then it should work. 
 
Another possibility would be to create rules for every field rather than by section, but this could 
require a lot more visibility rules. 

 

Foreign Characters Not Displaying Correctly 

I am trying to build a simple form, but all submitted values with foreign letters (for example: ć, 
č, ž, š, đ) are showing as an question mark. How do I fix this? 

Please check in your PHPMyAdmin to see whether your database CONNECTION (not the collation) 
is set to UTF8. If it isn't, then please change it, save the change and then test your form. It should 
work. 

 
 

Is there a way to reduce the size of the captcha box?  

You can make changes to the settings in this file: 
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/components/com_breezingforms/images/captcha/securimage_show.php 

 
If you want to change some of the styling for the Captcha box, you could also check the bfCaptcha 
settings in this file: 

/components/com_breezingforms/themes/quickmode/system.css 

 
 
 

Select List Calculations - Averaging 

My form has four "Select from list" fields each with six options ranked 1 to 6. I want to have a 
field that shows the sum of these four fields divided by 4 (to have the average) and multiplied 
by 1.66 (to have a grade on a scale of 10). Can I do that? 

Add a textfield (probably set it to read-only) and give it the name - not title - "result". 
 
In the advanced tab for each select list, go to the Actionscript section, and then put a custom action 
on each select list: 
 
To do that, go to the select-list element => advanced tab => Actionscript => click "custom" => check 
the "change" checkbox => click "create code framework". 
 
Right after "case 'change':" put this: 

ff_getElementByName('result').value = ( ( Number( 

ff_getElementByName('SELECT-1').value ) + Number( 

ff_getElementByName('SELECT-2').value ) + Number( 

ff_getElementByName('SELECT-3').value ) + Number( 

ff_getElementByName('SELECT-4').value ) ) / 4 ) * 1.66; 

 
(Replace the names SELECT-* with the real names of the select lists you are using and you should 
be fine.) 

 
 
Copied Form Not Retaining Validation Rules 

I have a form created in Quickmode and have a number of fields that are required. I have 
ticked the necessary "Required" box and selected the FF::ff_valuenotempty validation script, 
but the form still submits with empty fields.What's wrong? 
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There is sometimes a problem when using a copy of a form where the form gets duplicated but the 
elements don't map correctly, causing a conflict in the database. The workaround is to copy the 
original form by creating a package: 
 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=77 

 
 
Then, once saved, install the package with the form back into the form list: 
 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=78 

 
 
Then open the form you just installed (you can tell which one it is because it will have a higher ID 
number), and save the form once as it is. Once you have done that, rename the form, click on the 
SAVE PROPERTIES button to save the change you just made, and then click on the SAVE icon in 
the upper right-hand corner of the screen to save the form itself. Those steps somehow remap 
everything so it all works properly again. 

 
 
 

Redirect User to a Different URL based on Select-List Choice 

  

My form has a drop-down list with several choices. Once they have filled in all the fields on 
the page and click SUBMIT, I want to redirect the user to another web page based on the 
choice they made in the drop-down list. Is this possible? 

  

  

Create a select-list as you would normally. For this example,  we'll name it 'pick,' and give it the 
following variables: 

0;First Choice;value1 

0;Second Choice;value2 

0;Third Choice;value3 

 
Save your element properties, then save your form. 
 
Now go to your form's properties > Advanced tab > More Options > Submit Pieces tab.  In the END 

http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=77
http://crosstec.de/support/index.php?pid=knowledgebase&cmd=viewentclient&id=78
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SUBMIT section, click on the "Custom" radio button. In the text area that opens, enter the following 
code: 

$this->execPieceByName('ff_InitLib');  

$value = ff_getSubmit('pick'); 

switch( $value ){ 

   case 'value1': header('Location: http://crosstec.de'); exit; 

break; 

  case 'value2': header('Location: 

http://crosstec.de/forums.html'); exit; break; 

  case 'value3': header('http://crosstec.de/support/get-

started'); exit; break; 

} 

 

 

In the $value line, change 'pick' to the name of your select-list element. 
 
in the 'case' lines, change 'value1', 'value2', and 'value3' to the values of your select-list choices, 
and then change out the location URLs for whatever URLs you want to redirect to. Click the SAVE 
button at the bottom of the screen, and then click on the SAVE icon in the upper right-hand corner of 
the screen to save your form. 

Upon submit, they will be taken to the URL based on the choice they made. 

 

Masked Input for Fields 

  

Is there a way to use masked inputting with elements in BreezingForms? 

  

Go to this site: 

github.com/digitalBush/jquery.maskedinput 

 
 
and download the Masked Input plugin zipfile. 
 
Unzip the zip file. Create a new folder on your server (let's call it "maskedinput") to house the 
contents. I created mine as follows: 

/includes/js/maskedinput/ 

https://github.com/digitalBush/jquery.maskedinput
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Now upload the contents (files and folders) of the unzipped file to the /maskedinput/ folder. 
 
Once you've done that, you need to create your form and connect it to a menu item so you can view 
it. Open the page that contains the form, and click on View Source.  
 
You now need to find the ELEMENT ID for each element that you want to use with the Input Mask 
script. (In my case, I added three text elements to my form: date, phone, and SSN.)  
 
Here is the HTML code for the date element in my form: 

Code: 

 
 

<input class="ff_elem" type="text" name="ff_nm_date[]" value="" id="ff_elem11

76"/> 

 

 
 
The ELEMENT ID for the date field is at the end: ff_elem1176 
 
 
Here is the HTML code for the phone element in my form: 

Code: 

 
 

<input class="ff_elem" type="text" name="ff_nm_phone[]" value="" id="ff_elem1

177"/> 

 

 
 
The element ID for the phone field is: ff_elem1177 
 
 
Make a note of the ELEMENT ID for each element that you are using masked input for. 
 
 
Now go back to BreezingForms to your form's properties > Advanced tab > More Options > Form 
pieces. In the "Before Form" section, click on the CUSTOM button. 
 
A text box will open. In that box, enter the following code: 
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Code: 

 
 

echo '<script src="/includes/js/maskedinput/src/jquery.maskedinput.js" type="

text/javascript"></script>'; 

 

echo '<script> 

JQuery(function($){ 

   $("#ff_elem1176").mask("99/99/9999"); 

   $("#ff_elem1177").mask("(999) 999-9999"); 

   $("#ff_elem1178").mask("999-99-9999"); 

}); 

</script>'; 

 

** NOTE: If you upload the maskedinput files and folders to a different directory, then you 
will need to change the location in the script src above. ** 

 
 
You can then replace the element IDs from the example above with your own element IDs, setting 
the mask format as needed. (Refer to the Input Mask documentation to see what formats are 
available.) 
 
Now click on the SAVE button at the bottom of the screen to save your Form Piece changes. Then 
click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. Now test 
your form -- it should work! 

 

Could Not Instantiate Mail Function Error 

 When I test my form, it generates a "Could not instantiate mail function" error and the form 
isn't sent. What's wrong? 

 
That error message is usually generated if your Joomla Global Config mail settings are not right. It 
could be that you need to use Sendmail or SMTP instead of PHPmailer (most common), or it could 
be that there is an error in your Email settings. 
 
First, try chchanging your Global Config first to sendmail and see if the Email goes through without 
an error being generated. If it does, then that was the issue. If it doesn't, then try again but changing 
the mail setting to SMTP. If neither of those remove the error, please contact support. 
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Calendar Doesn't Display in French 

I want my calendar to display dates, etc. in French. How can I do that? 

  

There is no native French translation of the calendar, but you can do so manually. In version 1.7.3, 
go to: 

/components/com_breezingforms/libraries/js/calendar/lang/ 

There you will see a file called "calendar-en-GB.js" 
 
Make a copy of that file and rename it to "calendar-fr-FR.js" -- then edit the translations there. 
 
Once you have done that, the calendar should be in French. 

 

 

Unable to Drag or Drop Elements in EasyMode 

I'm trying to create a form in EasyMode but I can't drag any of the elements to the form 
screen. What's wrong? 

Some templates install a version of jQuery called "SC jQuery." It appears to conflict with 
BreezingForms in the back end. So if you find this happening, check your plugins to see whether you 
have one called: 

System - SC jQuery 

If you do,  go into the plugin settings and change "Enable plugin for backend" from YES to NO. 

Then test it again. 

 

Can't Add Any More Elements to My Form 

  

I am creating a form, but I get to a certain point, and it won't let me add any more elements! 
Help!! 

For some reason, this sometimes happens if you are using Internet Explorer to create your form.  (It 
becomes painfully slow to save the form, too.) 
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Please try creating/editing the form in Firefox or Chrome to see if that resolves the issue. If the same 
thing happens in those browsers, please contact support for further assistance. 

 

How to Make Text Disappear When Field Clicked 

  

Instead of using labels, I want to put 'hints' in the field values that will disappear when a user 
clicks on them. How do I do that? 

Create a new text element or textarea element. For the purpose of this example, give it the following 
properties: 

Type: Textfield - OR - Textarea 

Label: Message 

Name: message 

Value: Please write your message here. 

(The other fields can be completed however want.)  

Go to the element's Advanced tab. In the ACTIONSCRIPT section, add the following: 

 
Type: Custom 

Actions: CLICK and BLUR should be checked 

In the textarea that opens, enter the following code: 

Code: 

 
 

function ff_message_action(element, action) 

{ 

switch (action) { 

case 'click': 

if (element.value=='Please write your message here.'){element.value=''}; 

break; 

 

case 'blur': 

if (element.value==''){element.value='Please write your message here.'}; 

break; 

default:; 
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} 

} // ff_message_action 

 

Make sure that the function name ( ff_message_action(element,action ) contains the name of the 
element as entered in the NAME field of the properties tab. (In our example, we named it message.) 

If you change the name to something other than message, then you will need to change the function 
name to match it. For example, if you name the element "Phone," then that first line of the 
actionscript should read: 

ff_Phone_action(element,action 

Also, the element.value in the code above must be the same as the value you put in the VALUE field 
on the element's properties tab. In our example, the element.value is entered as: 

Please write your message here. 

which matches the value that we entered earlier. If you change the value in the element's properties 
to: 

(555) 555-5555  

then your script (assuming it is now a 'Phone' element instead of a 'message' element) would 
change to: 

 

Code: 

 
 

function ff_Phone_action(element, action) 

{ 

switch (action) { 

case 'click': 

if (element.value=='(555) 555-5555'){element.value=''}; 

break; 

 

case 'blur': 

if (element.value==''){element.value='(555) 555-5555'}; 

break; 

default:; 

} 

} // ff_Phone_action 
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Now click on the SAVE PROPERTIES button at the bottom of the screen to save the element you 
just created. 

Then click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 

Now test it -- just like magic, you should have some disappearing text! :-) 

 

Allow User to Edit Form 

Can a user edit their form? 

A user can edit their form if: 
 
1. They are logged in when they complete the form; and 
 
2. In the menu item where you connect the form, you set the "Submission editable by user?" 
parameter to YES. 

 

Captcha Not Stopping Spam 

I have Captcha implemented, but it isn't stopping spam from getting through. Help! 

Here is something you can try: 

1. Create a new hidden input element as the first element of your form. 

NAME: yourfirstname 

VALUE: empty (don't put anything in the value field) 
 
2. In your form's properties > Advanced tab > More Options > Submit Pieces > Before Submit, add 
the following code: 

$this->execPieceByName('ff_InitLib'); 

if( ff_getSubmit('yourfirstname') != '' ){ 

exit; 

} 

 
The regular bots will try to fill in this element and before form submit. The code above will exit the 
application if this element is not empty, which would result in the submission not being stored. 
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Copy Element Value to Another Element 

I have a billing and shipping address section in my form. I want to add a checkbox that says 
"Same as Billing" which would automatically copy the field data from each field to 
corresponding fields in the shipping section. Is that possible? 

  

Yes, this is indeed possible. To do this, you need to create a custom action in the "Same as Billing" 
checkbox element that would generate the copying of the fields. 
 
Go to the checkbox element's properties => Advanced tab and scroll down to the Actionscript 
section.  
 
TYPE: Custom 
ACTIONS: Check the "Click" checkbox 
 
Then click on the "generate code framework" text. If a popup alert appears, click YES. 
 
Into the generated function that appears in the textarea, right after this line: 

case 'click': 

Add this line for each element that you need to copy from the shipping section and add to the billing 
section: 

ff_getElementByName('TARGET_ELEMENT').value =  

ff_getElementByName('SOURCE_ELEMENT').value; 

 
(Replace TARGET_ELEMENT and SOURCE_ELEMENT with the names that you are using for the 
elements.) 
 
For multiple elements, just repeat the line for each additional one you need to get the value for. 

Click on the "Save Properties" button at the bottom of the screen to save your element changes, and 
then click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 
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Calendar in Easy Mode 

How do I create a calendar in EasyMode? 

For the calendar in EasyMode, you need to create a textfield first which will end up 'holding' the date 
that is picked. For this example, let's name it date 
 
Then you need to create the calendar element. In the options, it has a field that says: 
 
Connect With Field (name):  
 
Enter date in that field. Then click on the Update button. 
 
Now you need to make sure that you have added a 'submit' or 'next page' button (whichever is 
appropriate) that has an action script assigned to it. The settings should be: 
 
Type: Library 
Actions: Click (should be checked) 
Script: FF::ff_validate_submit (if it is a one-page form) 
 
or 
 
Script: FF::ff_validate_nextpage (if it is a multi-page form) 
 
Then click the Update button and then save the form. Now you should see the date picker in your 
form. 

 

PHP Error - Allowed Memory Size 

I am getting an error on my site -- not all the time, but quite often:  

The website encountered an error while retrieving [URL] . It may be down for maintenance or 
configured incorrectly. 
Here are some suggestions: 
Reload this web page later. 
HTTP Error 500 (Internal Server Error): An unexpected condition was encountered while the 
server was attempting to fulfill the request. 
How can I fix this?  

Take a look at Help > System Info > PHP Information and see what the memory_limit is set to? If it is 
only 8MB, then you likely have too little memory available in the php.ini settings of your hosting 
account.  
 
If that is the case, to resolve it, contact your host and ask them to increase memory (memory_limit) 
to at least 32 MB and then see if the error disappears. 
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Catchable Fatal Error When Saving Form 

When I to make changes to my form in the backend, I get an error message like this: 

Warning: fopen(/home/public_html/administrator/components/com_breezingforms/ajax_cach
e/ajaxsave_0_0.40857069558356207.txt) [function.fopen]: failed to open stream: No such file 
or directory in /home/public_html/libraries/joomla/filesystem/file.php on line 268 
 
Catchable fatal error: Argument 2 passed to QuickMode::save() must be an array, null given, 
called in 
/home/public_html/administrator/components/com_breezingforms/admin/quickmode.php on 
line 42 and defined in 
/home/public_html/administrator/components/com_breezingforms/admin/quickmode.class.ph
p on line 23 

How can I fix this? 

Check your form in a different browser. Does the same thing happen then? 
 
If it happens in other browsers, too, then the problem could be that the folder 
"/administrator/components/com_breezingforms/ajax_cache/" is not writable or that you need to 
activate the FTP layer in the Joomla global configuration settings, using the same login data you are 
using with your regular FTP client. 

 

How Do I Turn Autocomplete Off (or On) ? 

How do I turn autocomplete off when I'm completing a form? When I get to a new form field, it 
is trying to fill in other information from a previous form. I just want it to be blank. 

Autocomplete is a function of your browser. BreezingForms has no influence on this does, nor does 
it fetch any input from earlier sessions. You could check to see if it is being stored in Joomla caching 
and, if so, turn caching off.  
 
Otherwise, please see the documentation of your browser on how to deactivate the autocomplete 
function. 

 

Change Page on Condition 

I have a booking form where the user will have the option of adding details for additional travelers. Is 
there a way I can change the page conditionally based on the number they select? 

  

You can do this by putting a custom action on the element. For example, if you are using a select-list 
to show the number of travelers -- say from 1 to 6 -- your list would look like this: 
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0;1;1 
0;2;2 
0;3;3 
0;4;4 
0;5;5 
0;6;6 
 
For the purpose of this example, let's name the element NumberOfTravelers. 
 
Then go to the Advanced tab of the select-list.  
 
Type: CUSTOM 
Action: CHANGE (third checkbox from the left) 
 
Click on CREATE CODE FRAMEWORK. A screen will popup that says: 
 
Create code framework for action now? 
(Existing code will be appended) 
 
Click on OK. In the text area, you will see something like this: 

function ff_NumberOfTravelers_action(element, action) 

{ 

    switch (action) { 

        case 'change': 

            break; 

        default:; 

    } // switch 

} // ff_NumberOfTravelers_action 

 
Change it to: 
 
function ff_NumberOfTravelers_action(element, action) 

{ 

    switch (action) { 

        case 'change': 

if( element.value == '1' ){ 

  ff_switchpage(7); 

} else if( element.value == '2' ){ 

  ff_switchpage(2); 

} else if( element.value == '3' ){ 

  ff_switchpage(3); 

} else if( element.value == '4' ){ 

  ff_switchpage(4); 

} else if( element.value == '5' ){ 

  ff_switchpage(5); 

} else if( element.value == '6' ){ 

  ff_switchpage(6); 
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} 

            break; 

        default:; 

    } // switch 

} // ff_NumberOfTravelers_action 

 
 
IMPORTANT: If your element is named something OTHER than NumberOfTravelers, then you 
need to change the function to match the name. For example, if your element is named Travelers, 
then the function line would change to: 
 
function ff_Travelers_action(element, action) 

Change Field to Uppercase 

My form data needs to be entered in all UPPER CASE. Is there a way to do this?  

1. In your text element, go to the ADVANCED tab. 
 
2. In the ACTIONSCRIPT section, click on "Custom." 

3. In the "Actions" area, check the "Change" checkbox. (This will tell the script to activate any time 
the field is changed.) 

4. Click on CREATE CODE FRAMEWORK. (It's a link, though it doesn't look like one). A popup 
dialog box will appear that says: 

Create code framework for action now? 

(Existing code will be appended) 

5. Click OK. Code will then appear in that textarea that looks something like this: 

 

function ff_ElementName_action(element, action) 

{ 

   switch (action) { 
    switch (action) { 

        case 'change': 

            break; 

        default:; 

    } // switch 

} // ff_ElementName_action 

(Change "ElementName" in the first and last line of the code to match the NAME of your text 
element. This should be done automatically when you click on "Create Code Framework.") 
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5. Change that code to: 
6.  

function ff_ElementName_action(elem, action) 

{ 

  if (action=='change') 

   elem.value = elem.value.toUpperCase(); 

  return elem; 

} // ff_ElementName_action 

  

7. Click on the SAVE PROPERTIES button at the bottom of the screen to save the changes to the 
element. 

8. Click on the SAVE icon in the upper right-hand corner of the screen to save the form itself. 

9. Test it out -- it should work! 

 

How do I make a textfield Read-Only in EasyMode?  

To make a text element read-only in EasyMode, please do the following: 
 
1. Click on the Form Settings icon at the top of the page. 
 
2. Go to the SCRIPTS tab. 
 
3. In the "Initialization Script" section, click on "Custom." 
 
4. Click the "Create code framework" text. (It's a link.) A popup will appear that says: 
 
Create code framework for init now? 
(Existing code will be appended) 
 
Click "OK." 
 
5. A textarea will appear that looks something like this: 

function ff_YourFormName_init() 

{ 

} // ff_YourFormName_init 

 

 
After the first curly bracket, add: 
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ff_getElementByName("bla").readOnly=true; 

So the final code should look something like this: 

function ff_YourFormName_init() 

{ 

ff_getElementByName("bla").readOnly=true; 

} // ff_YourFormName_init 

Remember to change the "bla" in the getElementByName line to the actual name of your textfield 
element. Also, the "YourFormName" text in the first and last lines should actually match the name of 
your form. (This should happen automatically after clicking on Create code framework.) 

 
 

Captcha Image Not Displayed 

I added a captcha to my form, but the captcha image won't display. Help!  

Are you using Akeeba Admin Tools, by any chance? If so, please try this suggestion we received 
from another user: 
 
In Akeeba Admin Tools the following Exceptions have to be put in: 
 
components/com_breezingforms/images/captcha/securimage_show.php 
components/com_breezingforms/images/captcha/securimage.php 

 

 

 


